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Transcoding or processing a series of large files on one desktop computer is processor
intensive and time-consuming. You can increase speed and productivity by distributing
processing across multiple computers.

This preface covers the following:

• About the Apple Qmaster Distributed Processing System (p. 5)

• About the Distributed Processing Documentation (p. 6)

• Additional Resources (p. 6)

About the Apple Qmaster Distributed Processing System
High-volume processing is sometimes addressed by carefully managing multiple
computers; technicians set up batches of processing tasks for each computer and then
monitor their progress, collect and route the processed files, and start over again with
new batches. Although this is an improvement over the single-computer method, the
resource and process management can be laborious and slow.

The Apple Qmaster distributed processing system provides a more efficient solution,
handling all the work distribution and processing for you, behind the scenes.
Apple Qmaster and the Apple Qmaster features of Compressor manage the processing
across designated computers. They subdivide the work for speed, route the work to the
computers with the most available computing power, and direct the processing.

The Apple Qmaster system uses the processing capacity of your network computers for
a wide range of tasks, including transcoding and rendering for digital visual effects software
packages such as Apple Shake, Adobe After Effects, and Autodesk Maya.
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About the Distributed Processing Documentation
The Apple Qmaster distributed processing system is included with every copy of
Final Cut Studio and Shake. The system comes with various documents that help you get
started as well as provide detailed information about each of the applications. (To access
onscreen help for an application, open the application and choose the application’s help
from the Help menu.)

• Distributed Processing Setup Guide: This manual is the primary documentation for the
Apple Qmaster distributed processing system. The manual explains how to set up and
maintain a distributed processing network for use with Compressor or digital visual
effects software packages. It includes information on preparing a distributed processing
network, creating and administering clusters of computers, monitoring batches, and
using the system from the command line.

Although all of the chapters should be useful to administrators, client users (users who
are not administrators) may need to refer only to the Compressor User Manual or the
Apple Qmaster User Manual, and possibly to the introductory information in this
document, to understand how to use the Apple Qmaster distributed processing system
for their purposes.

The Distributed Processing Setup Guide is available in Compressor Help, Apple Qmaster
Help, and Apple Qadministrator Help.

• Compressor User Manual: This is a comprehensive document that describes the
Compressor interface, commands, and menus and gives step-by-step instructions for
using Compressor and accomplishing specific tasks. It is written for users of all levels
of experience. The Compressor User Manual is available in Compressor Help.

• Batch Monitor User Manual: This brief document describes how to use the Batch Monitor
application to monitor the transcoding progress of batches and jobs. The Batch Monitor
User Manual is available in Batch Monitor Help, Compressor Help, and Apple Qmaster
Help.

• Apple Qmaster User Manual: This document describes the Apple Qmaster client
application only. This is a specialized application for submitting jobs with Shake,
Autodesk Maya, and other digital visual effects software packages. The Apple Qmaster
User Manual is available in Apple Qmaster Help.

Additional Resources
Along with the documentation that comes with the Apple Qmaster software, there are
a variety of other resources you can use to find out more about the Apple Qmaster
distributed processing system.
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Final Cut Studio Website
For general information and updates, as well as the latest news on Final Cut Studio, go
to:

• http://www.apple.com/finalcutstudio

Compressor Website
For general information and updates, as well as the latest news on Compressor, go to:

• http://www.apple.com/finalcutstudio/compressor

Apple Service and Support Websites
For software updates and answers to the most frequently asked questions for all Apple
products, go to the general Apple Support webpage. You’ll also have access to product
specifications, reference documentation, and Apple and third-party product technical
articles.

• http://www.apple.com/support

For software updates, documentation, discussion forums, and answers to the most
frequently asked questions for Compressor, go to:

• http://www.apple.com/support/compressor

For discussion forums for all Apple products from around the world, where you can search
for an answer, post your question, or answer other users’ questions, go to:

• http://discussions.apple.com
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This section introduces most of the basic concepts and terms related to using the
Apple Qmaster distributed processing system.

This chapter covers the following:

• Using Distributed Processing to Increase Speed and Efficiency (p. 9)

• Basic Components of the Apple Qmaster Distributed Processing System (p. 10)

• QuickClusters (p. 13)

• Compressor AutoClusters (p. 13)

• How the Apple Qmaster System Distributes Batches (p. 13)

Using Distributed Processing to Increase Speed and Efficiency
Distributed processing accelerates processing by distributing the work to multiple
computers that have been chosen to provide more processing power. You can submit
batches of processing jobs to the Apple Qmaster distributed processing system, which
allocates those jobs to other computers in the most efficient way (described in more
detail in How the Apple Qmaster System Distributes Batches).

9

Distributed Processing Basics 1



Computers that submit batches to the Apple Qmaster distributed processing system are
called clients. A job is a processing task such as a Compressor preset-source pair, or a
Shake file, or other files or commands that use UNIX commands to specify settings such
as rendering instructions and file locations and destinations.

Batch of
processing jobs

Client computer
Jobs are submitted.

Destination folder
Files are placed at

specified destination.

Processed
files

Apple Qmaster cluster
Processing is

performed by cluster.

Network

A batch is one or more jobs submitted for processing at one time. The procedure is
analogous to printing multipage documents from a word processing program; the files
are spooled and processed in the background. Although a batch can include just one
job, you will typically want to submit several jobs at once for processing. Similarly, several
people can use the same Apple Qmaster system at the same time, with several client
computers sending batches in the same time frame. Batches are managed and distributed
by the computer that is designated as the Apple Qmaster cluster controller, which is
described in the next section.

Basic Components of the Apple Qmaster Distributed Processing
System
Although the Apple Qmaster software includes a few different applications (see The
Interfaces), as a whole it is part of a networked system that includes the following basic
components.

• Client(s): The computer or computers that use Compressor or Apple Qmaster to submit
jobs for distributed processing. Applications that can use Apple Qmaster services for
processing include Compressor, Shake, Autodesk Maya, and many UNIX command-line
programs.

• An Apple Qmaster cluster: An Apple Qmaster cluster contains:

• Service nodes: The computers that perform the processing of batches submitted via
Compressor or Apple Qmaster. A batch can include one or more jobs.
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• Cluster controller: The software, enabled on a computer by means of the
Apple Qmaster pane of System Preferences, that divides up batches, determines
which service nodes to send work to, and generally tracks and directs the processes.

Cluster controller manages the
distribution of client’s jobs across the cluster

Service node
processes jobs

Cluster
(can contain multiple service nodes, but only one cluster controller)

Client computer from
which users send jobs to the cluster

Service node
processes jobs

Service node
processes jobs

Service node
processes jobs

The client computer, the service nodes, and the cluster controller are often on separate
(but network-connected) computers, for the most rapid processing potential. However,
the cluster controller could be on a client computer or a service node. See Using One
Computer to Serve Two Distributed Processing Roles for more information on this scenario.

Following is a closer look at the part each component plays in the Apple Qmaster system.

Clients
Batches are submitted for distributed processing from the client computers. A client
computer can be any computer that has Compressor or Apple Qmaster installed and is
on the same network (subnet) as the cluster controller. Multiple client computers can be
on the same subnet, using the same cluster to do the processing for various applications.

You use Compressor or the Apple Qmaster application to submit batches to be processed
for a client. See the Compressor User Manual and the Apple Qmaster User Manual for details
on using these applications.

Note: On any given Final Cut Studio system or network, the Compressor and
Apple Qmaster versions (numbers) and the version of QuickTime must all match. For
example, Compressor 3.0.5 will work only with the 3.0.5 version of Apple Qmaster, and
no other version. In this example, the correct version of QuickTime is QuickTime 7.5.5 or
later. Non-matching configurations are not supported.
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Clusters
When a client sends batches to the Apple Qmaster distributed processing system, all the
processing and subsequent moving of any output files is performed by a group of
Apple Qmaster–configured computers called a cluster. You can create one or more clusters
of service nodes, with one cluster controller included in each cluster. Each computer in
the cluster is connected to the other computers in the cluster through a network
connection.

Cluster
controller

Service
node

Service
node

Service
node

Example of a cluster

Note: This illustration provides only one simple example of a cluster. Other possibilities
are described in Preparing a Network for Distributed Processing.

Service Nodes
The service nodes are where the processing work is done. When you assign a group of
service nodes to a cluster, they function as one very powerful computer because all their
resources are shared. If one service node is overloaded or otherwise inaccessible, another
service node is used.

You make a computer available as a service node by configuring it in the Apple Qmaster
pane of System Preferences. The simple steps involved in using System Preferences to
configure a service node are described in Administering Clusters.

Note: The terms processing and rendering will come up frequently as you read this
document. The term processing is used here in a general way to cover both rendering
(for Shake and other frame-based rendering applications) and encoding (or transcoding
or compression) for Compressor. For more information, see the Shake User Manual and
the Compressor User Manual.

Cluster Controllers
The cluster controller software acts as the manager of a cluster. The cluster controller
directs the distribution of batches within the cluster. It has the ability to determine the
best use of the cluster resources based on work and availability variables. (See How the
Apple Qmaster System Distributes Batches for more details.) The cluster controller is
responsible for accepting batch submissions, maintaining and managing the batch queue,
and doling out the work to the appropriate service node. It also tracks the status of all
outstanding batches.
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You make a computer available as a cluster controller by turning on the cluster–controlling
service in the Apple Qmaster pane of System Preferences.

QuickClusters
The QuickCluster feature of the Apple Qmaster distributed processing system is a simple
and automated alternative to creating and configuring clusters manually. For more
information about QuickClusters, see Creating QuickClusters.

Compressor AutoClusters
The AutoCluster feature in Compressor gives you an easy way to take advantage of the
distributed processing capabilities offered by Apple Qmaster without requiring a lot of
knowledge about how clusters are configured, setting up file sharing, and so on. For more
information about AutoClusters, see Using Compressor AutoClusters.

How the Apple Qmaster System Distributes Batches
The Apple Qmaster cluster controller determines the most efficient use of the cluster
resources. It makes this determination based on the availability of each service node and
the number of separable parts (described next) of the batch.

Because Apple Qmaster subdivides individual batches across different service nodes, the
work is shared and completed more quickly. And, because this method uses all the service
nodes as much as possible, you avoid under-utilizing your resources.

Batches can be distributed to a cluster by the cluster controller in one or both of the
following ways. (Apple Qmaster determines which way is the most efficient for specific
batches, depending on the circumstances.)

• The batch is subdivided into data segments: For example, for a render batch, the cluster
controller could divide the frames into groups (segments). Each segment would be
processed in parallel on the service nodes in the cluster.

• The batch is subdivided into tasks: For example, for a render batch, the cluster controller
could subdivide the rendering work into different processing tasks. Different tasks
would be run on different service nodes.
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Rather than actually moving segments, Apple Qmaster tells the service nodes which
segments to read via the network, where to find them, and what to do with them. Below
is an example of how one batch could be processed in an Apple Qmaster system.

Batch submitted by
Compressor or

Apple Qmaster (job request
for frames 1–30)

Cluster controller
divides and distributes

job to available
service nodes

Service node 1 Service node 2 Service node 3

Instructions specifying
locations of source files

and frames 11–20

Instructions specifying
locations of source files

and frames 21–30

Instructions specifying
locations of source files

and frames 01–10

Processed file (frames 1-30)
placed in specified

destination

In distributing batches, Apple Qmaster uses the technology built in to Mac OS X to locate
services in a cluster on the same IP subnet and to dynamically share and receive
information. Because the computers can continually transmit their current processing
availability status, Apple Qmaster can distribute (load-balance) the workload evenly across
the cluster.
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The Apple Qmaster distributed processing system has default settings that allow you to
use distributed processing immediately.

This chapter covers the following:

• Quick and Easy Distributed Processing (p. 15)

• About the Compressor Service Sharing Pane (p. 19)

Quick and Easy Distributed Processing
The steps below describe the simplest and quickest way to start using distributed
processing.

• Stage 1: Installing the Software

• Stage 2: Configuring a QuickCluster

• Stage 3: Adding Service Nodes to a Cluster

• Stage 4: Creating and Submitting a Batch

Stage 1: Installing the Software
Install the appropriate software on the computers you want to include in your distributed
processing network. Each computer in the network requires Apple Qmaster and/or
Compressor software.

To install the software
1 Make sure the client software is on at least one computer in your network.

In order to submit jobs and batches to the distributed processing system, you need to
use client (submission) software (either Compressor or Apple Qmaster). If you are reading
this, you have probably already installed one or both of these. For further information,
see the installation booklet that came with either of these applications.

2 Install Apple Qmaster software on each computer you want to use for distributed
processing. (All computers must be on the same subnet.) By default, the Final Cut Studio
installer installs the Apple Qmaster software necessary for distributed processing.
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However, in most standard distributed processing networks, you need to install
Apple Qmaster software on every computer in the network. You can use the standalone
Apple Qmaster Node Installer to install the Apple Qmaster software on additional
computers on your network.

a Locate the folder containing the Apple Qmaster software.

• If you are using Compressor: Insert the Final Cut Studio installation disc and locate
the Apple Qmaster Node Installer package (AppleQmasterNode.mpkg).

• If you are using Shake: Insert the Shake installation disc and locate the Apple Qmaster
Node Installer package (AppleQmasterNode.mpkg).

b Do one of the following:

• Double-click the AppleQmasterNode.mpkg installer package, and follow the onscreen
instructions. By default, this installer installs all the necessary Apple Qmaster software.

• Install Apple Qmaster software from the command line. See Installing Apple Qmaster
from the Command Line for more information.

Both the Final Cut Studio Installer and the Apple Qmaster Node Installer include the
Compressor Service Sharing pane, in which you can quickly set up the computer as an
unmanaged service node. See About the Compressor Service Sharing Pane for more
information.

Note: On any given Final Cut Studio system or network, the Compressor and
Apple Qmaster versions (numbers) and the version of QuickTime must all match. For
example, Compressor 3.0.5 will work only with the 3.0.5 version of Apple Qmaster, and
no other version. In this example, the correct version of QuickTime is QuickTime 7.5.5 or
later. Non-matching configurations are not supported.

Keep the following useful tips in mind as you prepare your Apple Qmaster distributed
processing system:

• If you are using the Apple Qmaster distributed processing system with Compressor or
Shake, all nodes (computers) in a cluster must have the same version of QuickTime
installed. To download the most recent version of QuickTime, go to
http://www.apple.com/quicktime/download/mac.html.

• In order to use the Apple Qmaster distributed processing system to process Dolby
Digital Professional audio, each node (computer) in your distributed processing network
must have Final Cut Studio installed.

• Shake users can create distributed processing clusters containing computers that do
not have any Apple Qmaster software installed. See the Apple Qmaster User Manual for
more information.
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Stage 2: Configuring a QuickCluster
Use the Apple Qmaster pane of System Preferences to configure the cluster controller
and service node computers.

To configure the cluster controller and service node computers
1 Open System Preferences.

2 Click the Apple Qmaster button, located in the Other section.

The Apple Qmaster pane appears.

3 If the pane is locked, unlock it by clicking the padlock in the lower-left corner to enter
the administrator name and password.

4 Click Start Sharing.

This creates a QuickCluster with this computer as its controller, and an instance of
processing services for each processor on the computer. For information about multiple
service instances, see Using Virtual Clusters to Make the Most of Multiprocessor Computers.

Stage 3: Adding Service Nodes to a Cluster
Do the following on each computer that you would like to make a service node on your
cluster.

To add a service node to a cluster
1 Open System Preferences.
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2 Click the Apple Qmaster button, located in the Other section.

The Apple Qmaster pane appears.

3 If the pane is locked, unlock it by clicking the padlock in the lower-left corner to enter
the administrator name and password.

4 Select “Services only.”

5 Click Start Sharing.

This creates a service node that will automatically process jobs submitted to the
QuickCluster you set up in Stage 2: Configuring a QuickCluster.

Stage 4: Creating and Submitting a Batch
In the Compressor Batch window or in the Apple Qmaster window, create a batch with
one or more jobs. See the Compressor User Manual or the Apple Qmaster User Manual for
details.

To submit the batch
1 Do one of the following:

• If you are using Compressor: In the Compressor Batch window, click Submit, and in the
resulting dialog, do one of the following:

• Use the Cluster pop-up menu to choose the cluster you created in stage 2.

• Leave the Cluster menu set to the default This Computer setting, and select the
“Include unmanaged services on other computers” checkbox. For more information
on this option, see Using Compressor AutoClusters.
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• If you are using Apple Qmaster: In the Apple Qmaster window, choose the cluster you
created in stage 2 from the Submit To pop-up menu.

2 Click Submit.

The distributed processing system processes the batch.

For more advanced information on creating and controlling clusters and services, see
any of the following:

• Basic Components of the Apple Qmaster Distributed Processing System

• Sample Setup for Part-Time Processing on Desktop Computers

• The Interfaces in the Apple Qmaster Distributed Processing System

• Apple Qmaster Pane of System Preferences

• Apple Qadministrator

• An Overview of Configuring a Cluster

• Configuring Service Nodes and Cluster Controllers

• Creating Clusters with Apple Qadministrator

• About QuickClusters

• Modifying and Deleting Clusters with Apple Qadministrator

About the Compressor Service Sharing Pane
Both the Final Cut Studio installer and the Apple Qmaster Node Installer include the
Compressor Service Sharing pane, in which you can quickly set up the computer as an
unmanaged service node. Selecting the Yes option in this pane is the first of two steps
in setting up AutoClusters in Compressor. An AutoCluster is a temporary QuickCluster
that you create automatically when you submit a batch. For more information about
AutoClusters, see Using Compressor AutoClusters.

Note: You can change any of these settings at a later time in the Apple Qmaster pane of
System Preferences.

If you are unsure which role each computer will play in your network, just install the
Apple Qmaster software on each computer in your network. You can sort out the details
later. See Basic Components of the Apple Qmaster Distributed Processing System for
additional information on what roles individual computers can play in the distributed
processing system.
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A distributed processing network can consist of as few as one or two computers, whereas
a high-volume network may include many computers, an Xserve system and Xserve
cluster nodes in a rack, and high-speed networking infrastructures.

You can scale up a distributed processing system as your workload demands by adding
features and devices to the network that supports it.

This chapter covers the following:

• The Minimum You Need to Know (p. 21)

• Example of a Minimal Distributed Processing Network (p. 22)

• Using Compressor AutoClusters (p. 23)

• Other Possible Components of a Distributed Processing Network (p. 24)

• Example of an Expanded Distributed Processing Network (p. 26)

• Sample Setup for Part-Time Processing on Desktop Computers (p. 26)

• Configuring Access for Part-Time Distributed Processing (p. 27)

• Setting Up for Part-Time Distributed Processing with Shake (p. 29)

• Additional Steps for Distributed Processing with Shake (p. 30)

The Minimum You Need to Know
The following are the basic rules for setting up a distributed processing network:

• A cluster must contain one (and only one) computer acting as the cluster controller,
and at least one computer acting as the service node. (These two can be the same
computer, as shown in Example of a Minimal Distributed Processing Network.)

• The client computers and the computers in any cluster that supports them must be
on the same network.

• The network must support the Apple networking technology built in to Mac OS X.

• All the computers in a cluster need read-and-write access to any computers (or storage
devices) that will be specified as output destinations for files.
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For information about a very basic setup, see Example of a Minimal Distributed Processing
Network.

Example of a Minimal Distributed Processing Network
A very small distributed processing setup could include as few as two computers:

• One computer connected to the client and configured to act as both the service node
and the cluster controller

• One client computer

Client Service node with
cluster controller enabled

Minimum setup for distributed processing

Though simple, this setup is useful in a small-scale environment because it allows the
client computer to offload a lot of processing work.

See Example of an Expanded Distributed Processing Network for an illustration of a more
powerful setup.

Using One Computer to Serve Two Distributed Processing Roles
To maximize your resources, you may want to consider using some computers for more
than one distributed processing function.

• Service node and cluster controller: In a small setup, one of the service nodes in a cluster
can also act as the cluster controller so that it performs both functions. However, in
a cluster of many service nodes, the processing load required for the cluster controller
could be so high that it would not be efficient to use one computer as both a service
node and a cluster controller.

• Client computer and cluster controller or service node: You could also set up a client
computer to act as a cluster controller or service node in a cluster, but again, keep in
mind that the more available processing power a computer has, the faster it can
manage or process jobs.
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Using Compressor AutoClusters
The AutoCluster feature in Compressor gives you an easy way to take advantage of the
distributed processing capabilities offered by Apple Qmaster without requiring a lot of
knowledge about how clusters are configured, how to set up file sharing, and so on.

Using AutoCluster is a two-step process:

• Automatically creating Apple Qmaster service nodes as you install Final Cut Studio or
Apple Qmaster

• Selecting “Include unmanaged services on other computers” when you submit a
Compressor batch for processing

These two steps let you harness the processing power of any number of computers on
your network without any additional effort or knowledge on your part.

• Stage 1: Creating Service Nodes During Installation

• Stage 2: Submitting Compressor Batches for Processing

Stage 1: Creating Service Nodes During Installation
Both the Final Cut Studio installer and the Apple Qmaster Node Installer include the
Compressor Service Sharing pane, in which you can quickly set up the computer as an
unmanaged Apple Qmaster service node, which is essentially a free agent “processing
slave,” available on the network for any computer that requests its services.

If you select Yes in this pane, the Apple Qmaster pane of System Preferences is configured
as follows:

• Share this computer as: Services only

• Compressor service: Selected, unmanaged

• Start Sharing: Started
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You can change any of these settings at a later time in the Apple Qmaster pane of System
Preferences. For more information, see Apple Qmaster Pane of System Preferences and
Administering Clusters.

Important: Although the Final Cut Studio installer requires a separate serial number for
each computer, you can use the Apple Qmaster Node Installer (available in the Extras
folder) to install the necessary Apple Qmaster software to make any computer on your
network into an Apple Qmaster service node.

Stage 2: Submitting Compressor Batches for Processing
When you submit a Compressor batch for processing, a dialog appears that allows you
to name the batch and select the computers to process the batch. At this point, you can
harness the processing power of all the computers you set up as service nodes in stage
1 to complete the batch.

To process the batch using AutoCluster
1 Leave the Cluster pop-up menu set to the default selection (This Computer).

2 Select the “Include unmanaged services on other computers” checkbox.

Compressor and Apple Qmaster coordinate the distribution of the processing tasks
between the available computers and deposit the resulting output files at the location(s)
you designated in Compressor.

Other Possible Components of a Distributed Processing Network
There are many ways to expand the capacity of a distributed processing network. You
could include any of the following.

• High-speed switch and cables: A 100Base-T or Gigabit Ethernet switch and compatible
cables to allow your data to move over the LAN at maximum speed.

• Multiple clients: Multiple client computers can use the services of the same cluster. And,
you can have multiple client applications on the same client computer, using the same
cluster.
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• Multiple clusters: Depending on how extensive your network is and how many clients
it needs to serve, you may want to divide up available computers and create more than
one cluster to serve various clients. (Users select the cluster they want to send a batch
to when they submit the batch.)

• Multiple service nodes: In general, more service nodes mean more processing power.
In deciding how many service nodes to have in a cluster, consider the ratio of data
movement time to computing time. If the processing demand is greater than the
network demand required to move job segments throughout the cluster, as is the case
with rendering, more service nodes are a good idea. If the computing load, per job, is
closer to the network load, having a smaller number of service nodes per cluster may
be more efficient. If you are using the Apple Qmaster distributed processing system
with applications other than Shake or Compressor, consult the application’s user manual
on how to optimize the number of service nodes.

• Storage device: A storage device, such as a remote disk or group of disk arrays, can be
used as cluster scratch storage, which is a place for short-term storage of temporary
data generated by the cluster controller, clients, and service nodes. (You set the scratch
storage location in the Apple Qmaster pane of System Preferences. See Using Cluster
Storage.) Alternatively, a storage device can be used as a final destination for the files
after they are processed.

For more information, see Example of an Expanded Distributed Processing Network.
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Example of an Expanded Distributed Processing Network
For rendering, a network might include a number of client computers on a LAN, connected
to a cluster using a high-speed switch. A rack of servers plus a shared storage device,
acting as the cluster, would be an extremely strong rendering engine. The service nodes
would each have a local copy of the relevant client application software so that they
could process the rendering jobs.

Client Client Client Client

Example of a network setup for distributed rendering

High-speed switches (chained together)

Rack of servers containing
cluster controller and service nodes,

plus rack-mounted shared storage device

LAN

Sample Setup for Part-Time Processing on Desktop Computers
This section takes you through the basic steps involved in a sample setup for “part-time”
distributed processing. You can use it to get an idea of the kind of distributed processing
environment you want to create, and as a guide in setting up that environment.
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This setup is for an environment that uses desktop computers. It is called “part-time”
processing because each computer acts as someone’s workstation, but at the same time
is also part of the distributed processing cluster. The bulk of the processing jobs can be
submitted with Compressor or Apple Qmaster at the end of the day, so that the computers
are busy processing a large queue of distributed processing batches after everyone has
gone home. (See Scheduling Service Availability in the Work Schedule Dialog for
information on scheduling service node availability.)

Network

FireWire
drive

FireWire
drive

FireWire
drive

FireWire
drive

FireWire
drive

Each computer acts as both
a client that submits jobs for processing and
a service node that performs the processing.

All source and output files are stored on the FireWire drives.

In the sample setup shown above, five computers act as both the clients (user workstations
from which users submit jobs for distributed processing) and cluster computers (which
do the processing). Each computer has an additional volume, such as a FireWire drive,
that is used for media before and after it is rendered, and for the associated files.

For more information on how to configure this desktop distributed processing
environment, see Configuring Access for Part-Time Distributed Processing.

Configuring Access for Part-Time Distributed Processing
Follow the instructions below to set up a “part-time” distributed processing system.

Before you get started, keep these essentials in mind:

• The cluster computers (cluster controller and service nodes) and the client computers
(user workstations) need to be on the same local network (subnet).
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• All the computers in the setup need read-and-write access to any volumes that will be
specified as the source location or output destination for files, including Shake scripts.
(An appropriate way to configure this access is included in the sample configuration
procedure below.)

Stage 1: Installing Compressor and/or Apple Qmaster
The necessary components of Compressor or Apple Qmaster need to be installed on each
computer. See Stage 1: Installing the Software for more information.

On any given Final Cut Studio system or network, the Compressor and Apple Qmaster
versions (numbers) and the version of QuickTime must all match. For example,
Compressor 3.0.5 will work only with the 3.0.5 version of Apple Qmaster, and no other
version. In this example, the correct version of QuickTime is QuickTime 7.5.5 or later.
Non-matching configurations are not supported.

Important: The Compressor distributed processing feature for Dolby Digital Professional
(AC-3) and Final Cut Pro is limited to computers that have Final Cut Studio installed.

Stage 2: Setting Up Media Storage
Make sure each computer has the necessary available storage, preferably a dedicated
media volume. For example, give each computer a second volume, such as a FireWire
drive, that is used for media. Each computer can use this volume for all source and
destination files associated with distributed processing.

If you are a Compressor user, you can skip to one of the following chapters to complete
the setup of your part-time distributed processing system:

• Getting Started Quickly

• Administering Clusters

If you are a Shake user and you cannot consolidate all of the necessary source files (Shake
scripts, media files, and so on) on a single-cluster storage volume, skip to Additional Steps
for Distributed Processing with Shake before going on to stage 3.

Stage 3: Creating a Cluster
First, use the Apple Qmaster pane of System Preferences to enable cluster controlling on
one of the computers and enable the processing services on all the computers (making
them service nodes). Then, you can assemble these computers as a cluster.
Apple Qadministrator may not be necessary. See Administering Clusters for detailed
instructions.

28 Chapter 3 Preparing a Network for Distributed Processing



Setting Up for Part-Time Distributed Processing with Shake
If you cannot consolidate all of the necessary source files (Shake scripts, media files, and
so on) on a single-cluster storage volume, follow the instructions below.

• Stage 1: Turning Off the Shake UNC Setting

• Stage 2: Turning On Personal File Sharing

• Stage 3: Mounting the Media Storage Volumes

Stage 1: Turning Off the Shake UNC Setting
To make sharing and volume mounting work smoothly in this setup, you need to turn
off the Shake UNC setting on each computer. The UNC setting uses the entire file
pathname, with the network address, in a convention that starts with
//ComputerName/DriveName/path. You don’t want Shake to use this filenaming convention
because it conflicts with the file sharing and volume mounting used in this setup.

Note: All the media volumes created in stage 2 of Configuring Access for Part-Time
Distributed Processing should have the same name.

In the three steps below, you make this change in a Shake startup .h file. As described in
the Shake documentation, the startup .h files, located in the startup directory, are used
to customize Shake settings (similar to setting preferences).

To turn off the UNC setting, do the following on each of the computers
1 Log in as the user who will use Shake on the computer.

2 Double-click the Terminal icon in /Applications/Utilities/ to open a Terminal window.

3 Enter these two command lines in the Terminal window, pressing Return after each
command line:

mkdir -p ~/nreal/include/startup/

echo 'script.uncFileNames = 0;' > ~/nreal/include/startup/UNC_off.h

Stage 2: Turning On Personal File Sharing
On each computer, turn on Personal File Sharing. This allows the computers to share the
media volumes.

To turn on Personal File Sharing
1 Open System Preferences.

2 Click Sharing.

3 Select the File Sharing checkbox.

Stage 3: Mounting the Media Storage Volumes
Follow the instructions below so that all the computers in the cluster are mounting all
the media volumes in the cluster.
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To mount the media storage volumes
1 On each computer, log in as the administrator. (The first user account you create when

you set up Mac OS X is an administrator account.)

2 On each computer in the group, use the Connect to Server command in the Finder’s Go
menu to mount each media volume.

3 Enter another computer’s name in the Connect to Server dialog.

4 Choose the associated media volume as the volume you want to mount.

5 Repeat steps 1 through 4 until all the computers are mounting all the media volumes in
the cluster.

Additional Steps for Distributed Processing with Shake
The following additional steps may be necessary for Shake users.

Submitting Processing Jobs in the Sample Part-Time Distributed
Processing Setup
After you finish the final stage in Setting Up for Part-Time Distributed Processing with
Shake, each one of these computers can be used to submit jobs for distributed processing.

Because of the way access has been configured in Setting Up for Part-Time Distributed
Processing with Shake, all file pathnames are conveniently consistent and simple for the
purposes of specifying them in Compressor, in Shake scripts, and in Apple Qmaster,
assuming that:

• Users place the source media on a mounted media volume (one of the FireWire drives).

• Users place the Shake scripts on a mounted media volume.

• All folders and files on the shared media volumes have read-and-write access enabled
for everyone (for Owner, Group, and Others). You can configure this access setting by
selecting the folder or file and choosing File > Get Info.

These three assumptions are important because they ensure that all the computers have
read-and-write access to all the source files and output destinations.

Specifying Media File and Script Locations
The following additional configuration guidelines apply to anyone using Shake (or any
other UNIX-based rendering applications).

Specifying the Media File Locations in Shake Scripts
As you follow the steps in Setting Up for Part-Time Distributed Processing with Shake, all
the Shake render scripts should specify their source media (File In) locations and output
(File Out) destinations as /Volumes/MediaDiskName/ (for example, /Volumes/Media3/).
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Specifying Shake Script Locations in Apple Qmaster
As you follow the steps in Setting Up for Part-Time Distributed Processing with Shake, all
the Shake script locations should be specified in Apple Qmaster as
/Volumes/MediaDiskName/ScriptFilename (for example, /Volumes/Media3/Script.shk).
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Instead of one individual interface, the Apple Qmaster distributed processing system
includes up to four different applications and utilities for configuring, monitoring, and
managing services.

This chapter covers the following:

• The Interfaces in the Apple Qmaster Distributed Processing System (p. 33)

• Apple Qmaster Pane of System Preferences (p. 35)

• Apple Qadministrator (p. 41)

• Compressor and Apple Qmaster as Client Interfaces (p. 43)

• Batch Monitor (p. 45)

The Interfaces in the Apple Qmaster Distributed Processing
System
The Apple Qmaster system is a suite of applications that work together to provide
maximum power and flexibility for distributed processing. The elements of the system
can be combined in a variety of ways to suit your needs.
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In general, you use the Apple Qmaster pane of System Preferences to configure service
nodes and cluster controllers and to create simple clusters. System administrators use
Apple Qadministrator for advanced cluster creation and control. Client users use
Compressor or Apple Qmaster to submit batches of jobs for processing. Finally,
Batch Monitor can be used by both administrators and client users to monitor and manage
batches.

Apple Qadministrator

Batch Monitor

QuickCluster

Users:  Administrators and client users
Use to:  Monitor batches that have

been sent to clusters

System Preferences

Users:  Administrators
Use to:  Create service nodes and

cluster controllers

Users:  Administrators
Use to:  Assemble clusters of service nodes

and cluster controllers

Compressor or Apple Qmaster

Users:  Client users
Use to:  Submit jobs to clusters

for processing

Note: It is possible to create a simple (personal) distributed processing system and skip
Apple Qadministrator altogether. See Apple Qmaster Pane of System Preferences and
About QuickClusters for more information.
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Apple Qmaster Pane of System Preferences
Use the Apple Qmaster pane of System Preferences to activate, create, or make changes
to Apple Qmaster cluster-controlling and processing services (including passwords and
scratch storage locations).

Use Apple Qmaster System Preferences to configure 
service nodes and cluster controllers:

Cluster
controller

Service
node

For details about using the Apple Qmaster pane of System Preferences, see:

• Configuring Service Nodes and Cluster Controllers

• Using Virtual Clusters to Make the Most of Multiprocessor Computers

• Setting a Service Password for Including a Computer in a Cluster

• Using Cluster Storage

Also see the Apple Qmaster User Manual for more information, including information
about creating an extended node cluster that uses nodes without Apple Qmaster installed.

To open the Apple Qmaster pane of System Preferences
1 Open System Preferences.

2 Click the Apple Qmaster button, located in the Other section.
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The Apple Qmaster pane appears.
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About Basic Settings in the Apple Qmaster Preferences Pane
You can use the Setup pane within the Apple Qmaster preferences pane to configure
your distributed processing system.

Sharing Settings
• “Share this computer as” buttons: Use these buttons to assign a distributed processing

role to your computer.

• QuickCluster with services: Select this option to create an “instant” cluster with
unmanaged services. See About QuickClusters for more information.

• Services and cluster controller: Select this option to build a cluster in
Apple Qadministrator. See Creating Clusters with Apple Qadministrator for more
information.

• Services only: Select this option to make this computer a service node only. Service
nodes perform the processing of batches. They can be included in QuickClusters or
in managed clusters. See Managed vs. Unmanaged Services for more information.

Services Settings
• Share checkboxes: Use these checkboxes to enable or disable a specific (Compressor

or Rendering) service. For more information, see Turning Cluster Controller Services
On or Off.

• Managed checkboxes: Use these checkboxes to make the shared service unmanaged
(the default) or managed. For more information, see Managed vs. Unmanaged Services.
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• “Options for selected service” button: Click this button to open a dialog in which you can
you can adjust the number of instances of a processing service. For more information,
see Using Virtual Clusters to Make the Most of Multiprocessor Computers.

QuickCluster Settings
• “Identify this QuickCluster as” field: Use this field to change the name of a QuickCluster.

For more information, see About QuickClusters.

• “Include unmanaged services from other computers” checkbox: Select this checkbox to
have Compressor and Apple Qmaster use the available unmanaged computers on your
network for distributed processing. For more information on this option, see About
QuickClusters and Managed vs. Unmanaged Services.

Security Settings
• “Require password” checkbox: If you want to control who is able to include a specific

service node or cluster controller in a cluster, select this checkbox to open a password
dialog to enter and verify a password. For more information, see Setting a Service
Password for Including a Computer in a Cluster.

• Change Password button: Click this button to open a password dialog to enter and
verify a new password.

Start Sharing, Reset Services, and Lock Settings
• Start Sharing button: Click this button to enable the service node or cluster controller

you are setting up.

• Reset Services button: Click this button to restart services in the Apple Qmaster distributed
processing system.

• “Click the lock to make changes/Click the lock to prevent further changes” button: If the
“Click the lock to make changes” message appears next to the lock, click the lock icon
and type the administrator user name and password for your computer.
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About Advanced Settings in the Apple Qmaster Preferences Pane
You can use the Advanced pane within the Apple Qmaster preferences pane to further
configure your distributed processing system.

Advanced Service Settings
Use these features to schedule service restarts and service availability.

• “Restart all services every 24 hours” checkbox: Selecting the “Restart all services every
24 hours” checkbox ensures a robust distributed processing system. Refreshing the
services periodically prevents increased virtual memory sizes and memory leaks in
third-party software.

• “Set schedule for unmanaged services” button: If you enabled unmanaged services, you
can open a calendar interface and schedule the availability of these services to the
distributed processing system. For information on using the calendar interface, see
Scheduling Service Availability.

Shared Cluster Storage
Use these features to configure scratch storage for this computer’s cluster controller. For
more information on cluster storage, see Using Cluster Storage.

• Delete Files Older Than N Days field: Enter the number of days temporary process files
may remain on the cluster’s scratch location before they are automatically deleted. If
you anticipate a transcoding session that will last up to seven days or longer, you must
adjust this value.
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• Cluster Storage button: Enter a local folder directory to change the scratch location for
the cluster’s temporary process files. See Using Cluster Storage for more information.

Network
Use these features to configure network settings.

• “Allow discovery via Bonjour” checkbox: By default, this checkbox is selected to have the
Apple Qmaster distributed processing system use the Bonjour networking technology.
You can deselect the “Allow discovery via Bonjour” checkbox for enhanced security.
This will prevent detection of your computer over a Bonjour network. This feature
requires Mac OS X v10.4 or later.

• “Use Network Interface” pop-up menu: Restrict distributed processing activity to a
particular network interface card by choosing it from this pop-up menu. If you do this
on a service node computer, use a different computer to submit Compressor jobs and
batches.

• “Enable Port Range” checkbox and fields: You can define which ports Apple Qmaster
uses for service advertisements with the Enable Port Range checkbox and text fields
in the Network section of the Advanced pane within the Apple Qmaster pane of System
Preferences. For more information, see Defining Ports for Service Advertisements.

Extras
Use these features to configure additional settings.

• “Log service activity to file” checkbox: If this checkbox is selected, an activity log is created
and updated regularly with information about the Apple Qmaster actions on this
computer. Logs are stored in /Library/Logs/Qmaster/. To turn this feature off, deselect
the checkbox.

Note: You can also access this log information using the Log button in
Apple Qadministrator or the Log tab in Batch Monitor.

• “Show Apple Qmaster service status in menu bar” checkbox: If this checkbox is selected,
an Apple Qmaster icon appears in the computer’s menu bar. The menu bar item provides
Apple Qmaster status and activity information. For more information, see Service Node
Status Indicator in the Menu Bar.

• “Identify this computer to Qadministrator as” field: By default, a computer is identified
on the network by its computer name (as it is entered in the Sharing pane of System
Preferences). You can change this name to something more meaningful if you like,
since it is the name used to identify this computer in the Apple Qadministrator
application. If you are setting up a managed cluster controller, this is the name that
will appear in the Apple Qadministrator Controller pop-up menu.
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Apple Qadministrator
Use the Apple Qadministrator application to create and modify Apple Qmaster clusters.
Apple Qadministrator can be used on any computer that is on the same network as the
cluster you want to administer. With the administrator password (if one was created),
you can also use Apple Qadministrator to see and modify existing clusters on the network.

Use Apple Qadministrator to assemble clusters:

Drag available service
nodes to assign them
to a cluster.

For details about using Apple Qadministrator, see:

• Creating Clusters with Apple Qadministrator

• Modifying and Deleting Clusters with Apple Qadministrator

• Monitoring Cluster Activity

• Setting Preferences

• Setting Cluster Administrator and User Passwords

To open Apple Qadministrator
µ Double-click the Apple Qadministrator icon in the Applications folder.
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The Apple Qadministrator window appears. If a password was created for the currently
selected cluster, you will not be able to see or modify the cluster until you click the Lock
button and then enter the password in the dialog that appears.
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Compressor and Apple Qmaster as Client Interfaces
Client computer users use either Compressor or Apple Qmaster to submit batches for
processing.

Batch Batch

Batch Batch

Use Apple Qmaster to submit
a batch to a cluster:

Cluster A

Cluster B

Network

Use Compressor to submit
a batch to a cluster:

Using Compressor
Use the Cluster pop-up menu in the Compressor Batch window to choose a cluster for
any given batch. For more information on submitting batches with Compressor, see the
Compressor User Manual.

To open Compressor
µ Double-click the Compressor icon in the Applications folder.

43Chapter 4 The Interfaces



The Compressor default window layout appears.

Using Apple Qmaster
The Apple Qmaster application is the application that you use to submit distributed
processing jobs from digital visual effects software packages such as Shake, Autodesk
Maya, and any UNIX command-line program.

You can use any of the following workflows in Apple Qmaster:

• For Shake processing batches, you can drag Shake files into the Apple Qmaster window.
A default script for submitting the jobs is automatically created. In Apple Qmaster, you
can then specify certain details, such as which cluster to use, and make adjustments
to certain settings.

• For Maya batches, there is also a special interface within Apple Qmaster for submitting
and customizing Maya jobs.

• You can use the Generic Render command in Apple Qmaster for the distributed
processing of projects from other frame-based rendering applications (such as After
Effects and LightWave).

For complete information about the Apple Qmaster application, see the Apple Qmaster
User Manual.

To open Apple Qmaster
µ Double-click the Apple Qmaster icon in the Applications folder.
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The Apple Qmaster window appears.

Batch Monitor
As an administrator, you can use Batch Monitor to track the progress of all the batch
activity for all the clusters on your network. You can see how close to completion each
job is, along with other details, and you can stop, resume, or delete batches as well. If
you are a client user, you can use Batch Monitor to view and manage your own batches.

Use Batch Monitor to see information about batches
that have been sent to specified clusters:

Status of
batches

Status of
batches

Cluster Cluster

Network

For complete information about Batch Monitor, see the Batch Monitor User Manual.

To open Batch Monitor
Do one of the following:

µ Submit a batch with Compressor or Apple Qmaster. The Batch Monitor window opens
automatically depending on your preference setting.

µ Double-click the Batch Monitor icon in the Utilities folder in the Applications folder.

µ Click the Batch Monitor button in the Apple Qmaster window or in the Compressor Batch
window.

µ In Apple Qadministrator, choose Cluster > Show Batch Monitor.
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Batch Monitor opens.
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Once your network is set up and you have installed the necessary components, you are
ready to create distributed processing clusters.

If you have questions about any concepts and terms used here, see Distributed Processing
Basics.

This chapter covers the following:

• An Overview of Configuring a Cluster (p. 47)

• Configuring Service Nodes and Cluster Controllers (p. 48)

• Creating Clusters with Apple Qadministrator (p. 55)

• About QuickClusters (p. 58)

An Overview of Configuring a Cluster
Assuming Apple Qmaster software is installed on all the computers that you plan to use
as part of the cluster, there are three basic steps involved in configuring a cluster.

Note: On any given Final Cut Studio system or network, the Compressor and
Apple Qmaster versions (numbers) and the version of QuickTime must all match. For
example, Compressor 3.0.5 will work only with the 3.0.5 version of Apple Qmaster, and
no other version. In this example, the correct version of QuickTime is QuickTime 7.5.5 or
later. Non-matching configurations are not supported.

Stage 1: Configuring Service Nodes
Configuring a service node to perform distributed processing is a matter of turning on
processing services in the Apple Qmaster pane of System Preferences. Optionally, you
can also set passwords at this time. See Configuring Service Nodes and Cluster Controllers
for details.

Stage 2: Configuring a Cluster Controller
To configure a computer to control the cluster, turn on the cluster control services in the
Apple Qmaster pane of System Preferences. See Turning Cluster Controller Services On
or Off for more information.
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Stage 3: Creating a Cluster
You can create a simple QuickCluster in the Apple Qmaster pane of System Preferences,
or you can create a managed cluster from the service nodes and cluster controller using
Apple Qadministrator. After a cluster is created, client applications on the same network
can start sending batches to the cluster. You can use Apple Qadministrator from any
computer (with Apple Qadministrator installed) that is on the same network as an
Apple Qmaster cluster. See any of the following for more details:

• Getting Started Quickly

• Creating QuickClusters

• Creating Clusters with Apple Qadministrator

Note: If you are an Apple Qmaster user and you want to create a cluster that includes
computers that do not have Apple Qmaster installed, see the Apple Qmaster User Manual
for instructions.

Configuring Service Nodes and Cluster Controllers
Once service processing or cluster controlling is enabled on a computer, the computer
is advertised on the network as available to be used in a cluster.

Important: There can be only one cluster controller in a cluster. However, a computer
can be designated as both a cluster controller and a service node (see Using One Computer
to Serve Two Distributed Processing Roles).

Configuring Service Node Processing
Use the Apple Qmaster pane of System Preferences or Apple Qadministrator to set
processing services on a computer.

To turn on processing services
1 Open the Apple Qmaster pane of System Preferences.

2 Optionally, you can configure a number of settings before you turn on the processing
services. (See Scheduling Service Availability.)

Note: It’s easiest to do this now because you can’t configure these settings when
processing services are enabled. To configure these settings after services have been
enabled, you need to turn off the services, configure the settings, and then turn the
services on again.

3 In the “Share this computer as” section, select one of the following buttons:

• QuickCluster with services: Select this option to create an “instant” cluster with
unmanaged services. (See About QuickClusters for more information.)
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• Services and cluster controller: Select this option to build a cluster in
Apple Qadministrator. (See Creating Clusters with Apple Qadministrator for more
information.)

• Services only: Select this option to make this computer a service node only. Service
nodes perform the processing of batches. They can be included in QuickClusters or in
managed clusters. (See Managed vs. Unmanaged Services for more information.)

4 In the Services section, do one of the following:

• For Compressor services: In the Share column, select the checkbox for Compressor
Processing.

• For Apple Qmaster services: In the Share column, select the checkbox for Rendering.

5 Click Start Sharing.

The processing service is enabled, making this computer a service node that can process
batches.

Options in the Apple Qmaster Pane of System Preferences
You can configure any of the following settings before you turn on processing services.
(Changing any of the following settings requires that processing services be turned off.)
For a complete list of the options and settings in the Apple Qmaster pane of System
Preferences, see About Basic Settings in the Apple Qmaster Preferences Pane and About
Advanced Settings in the Apple Qmaster Preferences Pane.
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Setting the Name
By default, a computer is identified on the network by its computer name (as it is entered
in the Sharing pane in System Preferences). You can change this name to something
more meaningful if you like, since it is the name used to identify this computer in the
Apple Qmaster distributed processing system. If you are setting up a QuickCluster, this
is the name that will appear in the Compressor Cluster pop-up menu or the Apple Qmaster
Submit To pop-up menu. If you are setting up a managed cluster controller, this is the
name that will appear in the Apple Qadministrator Controller pop-up menu.

To enter a name for a QuickCluster
µ Enter the new name for the cluster in the “Identify this QuickCluster as” field.

To enter a name for a cluster controller for use with Apple Qadministrator
1 Click Advanced to open the Advanced pane.

2 Enter the new name in the “Identify this computer to Apple Qadministrator as” field.

Unmanaged Services
You can enable unmanaged services for a QuickCluster. For more information, see
Managed vs. Unmanaged Services.

Setting the Password
To add a password requirement, select the “Require password” checkbox.

• If you are setting up a QuickCluster: Other users will be required to enter this password
before being allowed to submit requests to this computer.

• If you are setting up a cluster to use with Apple Qadministrator: An administrator will be
required to enter this password before being allowed to add this computer to a cluster.

For more information, see Setting Passwords. (If you configure the computer as both a
cluster controller and a service node, this password is used for both.)

Setting Cluster Storage
You can change the default scratch storage location for processing that occurs on this
computer in the Advanced pane. For more information, see Using Cluster Storage.

Service Node Status Indicator in the Menu Bar
By default, once a service node is enabled, an Apple Qmaster icon appears in the
computer’s menu bar. The icon now changes color based on the service node’s current
status:

• Gray: Idle

• Green: Processing
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• Red: Connection failure

Click the icon to reveal additional information, including the service node’s IP address,
port number, and capture status, as well as a link to the Apple Qmaster pane of System
Preferences.

To show the service node status indicator in the menu bar
1 Open the Apple Qmaster pane of System Preferences.

2 Click Advanced to open the Advanced pane.

3 Select the “Show Qmaster service status in menu bar” checkbox.

Managed vs. Unmanaged Services
You have flexibility in how you build clusters for distributed processing with Compressor
or Apple Qmaster. When you turn on processing services (see Turning Cluster Controller
Services On or Off), you can choose to make them either managed services or unmanaged
services (the default).

Managed Services
Managed services can be assigned to serve one particular cluster controller. Once assigned,
managed services remain exclusively dedicated to that cluster until they are removed
with the Apple Qadministrator application. QuickClusters cannot use managed services
from other nodes, except in the case of extended node clusters. For more information,
see Modifying and Deleting Clusters with Apple Qadministrator. See the Apple Qmaster
User Manual for more information on extended node clusters.
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Unmanaged Services
Unmanaged services automatically assign themselves to the first available QuickCluster
with enabled unmanaged service support. QuickClusters listen for unmanaged service
advertisements and may mark or remember any of them for later use. A QuickCluster can
use any available unmanaged service on the same local network (subnet). An unmanaged
service remains dedicated to its QuickCluster only long enough to finish the current job.
Once the current job is complete, an unmanaged service is once again a “free agent” and
advertises its availability to all QuickClusters.

Note: Managed clusters (those created with Apple Qadministrator) can also use
unmanaged services. When unmanaged service support is enabled on a managed cluster,
the cluster automatically adds any available unmanaged services in addition to its managed
services (that were explicitly added using Apple Qadministrator).

Enabling Unmanaged Services on QuickClusters
Follow these steps to enable unmanaged services on QuickClusters.

To enable unmanaged services on QuickClusters
1 Open the Apple Qmaster pane of System Preferences.

2 Select the “QuickCluster with services” button to create a QuickCluster.

3 Select “Include unmanaged services from other computers.”

4 Click Start Sharing.

For more information on creating QuickClusters, see Getting Started Quickly and About
QuickClusters.

Enabling Unmanaged Services on Managed Clusters
Follow these steps to enable unmanaged services on managed clusters.

To enable unmanaged services on managed clusters
1 In Apple Qadministrator, select a cluster in the Cluster list, or click the Add (+) button to

add a new cluster.

2 Select “Allow use of unmanaged services.”

For more information on creating managed clusters, see Creating Clusters with
Apple Qadministrator.

Managing Processing Services
Follow the instructions below to manage the processing services on a computer in a
cluster.
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Note: If processing services are enabled, you must turn them off before you can adjust
the processing service type.

To set managed processing services
1 Open the Apple Qmaster pane of System Preferences.

2 Select the checkbox in the Managed column.

To set unmanaged processing services
1 Open the Apple Qmaster pane of System Preferences.

2 Deselect the checkbox in the Managed column.

To turn off processing services
1 In the Apple Qmaster pane of System Preferences, click Stop Sharing.

2 In the dialog that appears, enter the number of minutes you want processing services to
continue before shutting down, then click OK.

The default is 0 minutes, but you can enter a different number in the field. If you enter
any number greater than 0, a countdown appears next to the Cancel button. The shutdown
delay is provided as a way to allow computers to complete the processing of active
batches without interruption.

3 In the Services section, do one of the following:

• To turn off Compressor services: Deselect the On checkbox for Compressor Processing.

• To turn off Apple Qmaster services: Deselect the On checkbox for Rendering.

Turning Cluster Controller Services On or Off
Use the Services pane in the Apple Qmaster pane of System Preferences to turn the cluster
controller on or off on a specific computer.

To turn on cluster controller services
1 Open the Apple Qmaster pane of System Preferences.

2 Optionally, you can configure a number of settings before you turn on the processing
services. (See Scheduling Service Availability.)

Note: It’s easiest to do this now because you can’t configure these settings when
processing services are enabled. To configure these settings after services have been
enabled, you need to turn off the services, configure the settings, and then turn the
services on again.
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3 In the “Share this computer as” section, select one of the following buttons:

• QuickCluster with services: Select this option to create an “instant” cluster with
unmanaged services.

• Services and cluster controller: Select this option to build a cluster in
Apple Qadministrator. (See Creating Clusters with Apple Qadministrator for more
information.)

Also see Managed vs. Unmanaged Services for more information.

4 In the Share column, select the checkbox.

5 Click Start Sharing.

The cluster is enabled, making this computer a cluster controller.

To turn off cluster controller services
1 Open the Apple Qmaster pane of System Preferences.

2 Click Stop Sharing.

3 In the dialog that appears, enter the number of minutes you want controller services to
continue before shutting down, then click OK.

The default is 0 minutes, but you can enter a different number in the field. If you enter
any number greater than 0, a countdown appears next to the Cancel button. The shutdown
delay is provided as a way to allow computers to complete the processing of active
batches without interruption. No new cluster connections are allowed to occur as the
cluster controller is shutting down.

Note: Optionally, you can turn off the controller and just make the node a service node.
To do this, select “Services only” in the “Share this computer as” section.

Using Virtual Clusters to Make the Most of Multiprocessor Computers
If any of the service node computers in your network have multiple processors, you can
adjust the number of instances of a processing service, essentially creating virtual clusters
on individual computers. For processor-intensive work, having many instances may
increase speed and efficiency, depending on the processing application.

Note: By default, the Apple Qmaster system creates one Rendering service instance for
each processor. Rendering services are for Shake (with Apple Qmaster), Autodesk Maya,
and other UNIX command-line programs, as opposed to Compressor services, which are
solely for Compressor distributed processing. Consult the documentation that came with
the application to see if using each processor individually is ideal.

To change the number of instances of processing services on a computer
1 Open the Apple Qmaster pane of System Preferences.

2 Select the Compressor or Rendering service in the Services section.

3 Select “Options for selected service.”
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4 In the dialog that appears, choose the number of instances from the pop-up menu.

Choose the number
of instances from
the pop-up menu.

5 Click OK.

6 In the Services section, select the Share checkbox for the service.

Note: The Service Options dialog is also used to add extended nodes to a cluster, as
described in the Apple Qmaster User Manual.

Creating Clusters with Apple Qadministrator
Once you configure managed service nodes or cluster controllers, they are visible in
Apple Qadministrator, which you use to create and modify Apple Qmaster clusters.

There are two basic steps to creating a managed cluster with Apple Qadministrator. First,
you create a new cluster and choose the cluster controller. Then, you add service nodes
to the cluster.

• Stage 1: Creating a New Cluster

• Stage 2: Assigning Service Nodes

Stage 1: Creating a New Cluster
Use the following steps to create a cluster with Apple Qadministrator.

To create a new cluster
1 Open Apple Qadministrator, then do the following:

a Click the Add (+) button.
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b Select Untitled Cluster and rename it. (The cluster name you create will also appear in
the cluster pop-up menus in Batch Monitor and Apple Qmaster.)

... then rename the 
Untitled Cluster.

Click the Add button...

2 From the Controller pop-up menu, choose a cluster controller from those available on
the network.

Use this pop-up
menu to choose
a cluster controller.

Note: If a password was created for the cluster controller in System Preferences, a password
authentication dialog appears.

3 Optionally, create cluster passwords by clicking the Security tab and selecting and entering
the passwords you want.

• Administrator Password: If you create this password, administrators will need to know
it in order to modify this cluster and to view this cluster’s batches in Batch Monitor.

• User Password: If you create this password, users will need to know it in order to submit
batches to this cluster and to view those batches in Batch Monitor.

Stage 2: Assigning Service Nodes
Use the following steps to assign service nodes to a cluster.
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To add a service node to a cluster
1 If the Qmaster Service Browser is not already displayed, click the disclosure triangle to

see it.

Click this disclosure 
triangle to see
available nodes.

2 Add service nodes to the new cluster by dragging them from the Qmaster Service Browser
list at the bottom of the window to the cluster’s service nodes list.

If there is a closed lock icon next to a computer name, click the lock and enter the
password that was assigned to it in the Apple Qmaster pane of System Preferences.
Otherwise, you won’t be able to drag that service node to the cluster.

Service nodes that are already assigned to another cluster are not shown.

Drag nodes to this
list from the Service
Browser list.

Clicking this disclosure triangle 
displays each instance of the 
services set in System 
Preferences for this node.

Note: The computer names you see at the top level of the Name columns may appear
in one of three formats, depending on your configuration: the computer name (for
example, Lemur node), the Apple networking name (for example, Lemur-node.local), or
the network address for the computer (for example, 02030b-dhcp45.company.com).

3 When you have finished adding service nodes, click Apply.

Your cluster is now ready to process batches.
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Note: Although Apple Qadministrator currently allows you to create a cluster with
unmanaged services, valid clusters require at least one managed service for the cluster
to be viewable in Apple Qmaster, Compressor, and Batch Monitor.

About QuickClusters
QuickClusters offer a simple and automated way to create and configure clusters, as well
as an alternative to creating and configuring clusters manually with Apple Qadministrator.
QuickClusters with enabled unmanaged support automatically configure themselves and
use any available unmanaged services on the same local network (subnet). QuickClusters
listen for unmanaged service advertisements and may mark or remember any of them
for later use.

Creating QuickClusters
You can create and modify QuickClusters in the Apple Qmaster pane of System Preferences.

To create and modify QuickClusters
1 Open the Apple Qmaster pane of System Preferences.

2 Under “Share this computer as,” select “QuickCluster with services.”

3 Optionally, you can configure a number of settings before you turn on the processing
services. (See Scheduling Service Availability.)
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Note: It’s easiest to do this now because you can’t configure these settings when
processing services are enabled. To configure these settings after services have been
enabled, you need to turn off the services, configure the settings, and then turn the
services on again.

4 Click Start Sharing.

This creates a QuickCluster with this computer as its controller.

Note: With an active QuickCluster, Apple Qmaster users can create extended node clusters,
which contain one or more computers that do not have Apple Qmaster installed. See the
Apple Qmaster User Manual for more information.

About AutoClusters
The AutoCluster feature in Compressor gives you an easy way to take advantage of the
distributed processing capabilities offered by Apple Qmaster without requiring a lot of
knowledge about how clusters are configured, how to set up file sharing, and so on. The
AutoCluster feature in Compressor allows you to do the following steps, on the fly, with
just one click, at the moment of batch submission:

• Turn “This Computer” into a temporary QuickCluster. (The computer you are using
appears as “This Computer” in the Apple Qmaster distributed processing system.)

• Use unmanaged services from other computers.

For more details on AutoClusters, see Using Compressor AutoClusters.
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As the administrator of your distributed processing network, you can set a number of
cluster options and security controls. You may also want to know about failure notification
and recovery features.

If you have questions about any concepts and terms used here, see Distributed Processing
Basics.

This chapter covers the following:

• Modifying and Deleting Clusters with Apple Qadministrator (p. 61)

• Monitoring Cluster Activity (p. 63)

• Accessing Activity Logs (p. 63)

• Setting Preferences (p. 63)

• Setting Passwords (p. 67)

• Scheduling Service Availability (p. 68)

• Using Cluster Storage (p. 70)

• Defining Ports for Service Advertisements (p. 73)

• Recovery and Failure Notification Features (p. 73)

Modifying and Deleting Clusters with Apple Qadministrator
Using Apple Qadministrator, you can change and delete clusters. Once a cluster is
configured, you can use Apple Qadministrator to deactivate and reactivate the processing
services on a computer in the cluster, to add a service node to the cluster, or to remove
a service node from the cluster.

If you want to change the cluster controller in a cluster, you need to delete the cluster
and then re-create it with a new cluster controller.
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Note: Unless Apple Qadministrator and the QuickCluster are on the same computer,
QuickClusters are not visible in Apple Qadministrator. Only managed clusters can be
modified and deleted in Apple Qadministrator. Managed clusters are clusters that were
created in Apple Qadministrator. QuickClusters must be modified in the Apple Qmaster
pane of System Preferences.

To modify a cluster
1 Open Apple Qadministrator.

2 In the Cluster list (on the left side of the window), select the cluster you want to change.

If the cluster’s Service Nodes list isn’t already showing individual services, click the
disclosure triangle in the Name column to reveal them.

Make any of the following changes.

• To temporarily turn off the processing services on a computer in the cluster: Deselect the
Active checkbox for that service node.

• To remove a service node from the cluster: Select the computer and drag it back to the
Qmaster Service Browser at the bottom of the Apple Qadministrator window.

To remove nodes from
a cluster, drag them
to the Qmaster
Service Browser.

• To add a service node to the cluster: Drag it from the service browser list at the bottom
of the window to the service nodes list.

3 Click Apply.

Note: To turn off the service node or cluster controlling services on any computer within
a cluster, see Configuring Service Node Processing and Turning Cluster Controller Services
On or Off.

To change a cluster’s name in Apple Qadministrator
1 In the Cluster list, double-click the cluster name.
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2 Type a new name, then press Return.

To delete a cluster in Apple Qadministrator
1 In the Cluster list, select the cluster you want to delete.

2 Click the Remove (–) button.

Monitoring Cluster Activity
You can use Apple Qadministrator to find out what is happening within a cluster by
examining details (such as processor usage, which batch is being processed, disk space
usage, and data activity) about each node in the cluster.

To monitor cluster activity in Apple Qadministrator
1 In the Cluster list, select the cluster you want to examine.

2 Select a node in the cluster service nodes list.

3 Click the Info (I) button near the bottom of the Cluster list.

4 In the resulting window, click the CPU, Memory, Volume Info, and I/O Activity tabs to see
a variety of details about the selected node.

Accessing Activity Logs
Apple Qadministrator provides log information for a selected service or cluster. This
information is useful for troubleshooting distributed processing issues, and it can be
saved to a file and processed with XML tools and UNIX scripts.

To view or copy log information in Apple Qadministrator
1 In Apple Qadministrator, select the service or cluster whose log you wish to view.

2 Click the Log button near the bottom of the Cluster list.

A new window appears displaying the log information for the selected service or cluster.
The log file is deleted when you close the window.

Setting Preferences
You can use Apple Qadministrator preferences to configure several aspects of
Apple Qadministrator. These include setting preferences for specific cluster as well as
setting preferences for using Apple Qadministrator over a wide area network.

To set preferences for a cluster
1 Open Apple Qadministrator.

2 In the Cluster list, select the cluster for which you want to set preferences.
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3 Click Preferences.

Click Preferences
to display the
Preferences tab.

4 Set any of the preferences listed in About the Apple Qadministrator Preferences Tab.

To set preferences for using Apple Qadministrator over a wide area network
µ Choose Apple Qadministrator > Preferences, or press Command-Comma (,).

About the Apple Qadministrator Preferences Tab
This section describes the features available in the Apple Qadministrator Preferences tab.

Controls in the Apple Qadministrator Preferences Tab
You can use the Apple Qadministrator Preferences tab to configure a number of
Apple Qadministrator settings.

The Apple Qadministrator Preferences tab contains the following items.

Queue
Use the following settings to configure queue preferences in Apple Qadministrator.

• Maximum number of jobs in queue: Enter the maximum number of batches that can be
queued up at one time for this cluster. If the maximum number is reached, the cluster
does not accept new batches until there is an opening in the queue.

• Keep job history for: Set how long batches are listed in the History table of Batch Monitor.
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• Email notification for service down after: Set how much time should pass, after a service
becomes inaccessible, before the cluster controller sends an alert message to the
administrator. (See About the Work Schedule Dialog.)

• Status Interval: Set how often status information about this cluster should be generated
and sent to Batch Monitor.

Email Notification
To have the cluster controller send service failure alerts to an administrator, enter the
relevant information in the fields provided. See Recovery and Failure Notification Features
for more information.

Note: The Apple Qmaster distributed processing system does not currently support SMTP
servers that require authentication.

• Admin Email: Enter the administrator’s email address.

• Send with mail server: Enter the administrator’s mail server.

• Domain: Enter the cluster controller’s domain.

About the Apple Qadministrator Wide Area Network Preferences Window
You can set wide area network preferences by choosing Apple Qadministrator >
Preferences.

About Wide Area Network Preferences
The Apple Qadministrator wide area network preferences window includes the following
items:

Apple Qadministrator Wide Area Network Preferences Details
Use the following controls to configure wide area network preferences.

• “Enter IP addresses or ranges for manually selected computers” table: This table displays
information about remote host computers.

• Add/Remove button: Use the button to add or remove information about remote host
computers.
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Remote Computer Address Dialog
This dialog is displayed when you click the Add/Remove button in the main Preferences
dialog. Use this dialog to enter IP addresses or ranges for remote computers.

• Host and “Host IP address range” buttons: These buttons control whether this dialog is
in IP Address mode (in which you enter a specific address) or IP Address Range mode
(in which you enter a range of addresses).

• Host: Use this mode to enter a host name and IP address for a specific remote
computer.

• Host IP address range: Use this mode to enter a name and set of range numbers
(Range From, Range To) for a range of remote IP addresses.

Setting Wide Area Network Preferences
Follow the instructions below to set wide area network preferences for
Apple Qadministrator.

To enter IP addresses or ranges for remote computers
1 Click Add (+).

The host address dialog appears.

2 In the host address dialog, do one of the following:

• Select Host, complete the Host Name and IP Address fields, and click Add Host.

• Select “Host IP address range,” complete the Range fields, and click Add Range.
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The hosts or host ranges appear in the Host table in the main Preferences dialog.

Setting Passwords
You can create several types of passwords for the Apple Qmaster distributed processing
system. All these passwords are optional; you can use the system without creating them.

• Cluster administrator password: A password required for modifying a cluster in
Apple Qadministrator, and for modifying the status of the cluster’s batches in
Batch Monitor. See Setting Cluster Administrator and User Passwords.

• Cluster user password: A password that client users need in order to submit batches to
a cluster and to modify the status of those batches in Batch Monitor. See Setting Cluster
Administrator and User Passwords.

• Service password: A password required for an administrator to add a specific service
node or cluster controller to a cluster. See Setting a Service Password for Including a
Computer in a Cluster.

You can also change the default scratch storage location for a cluster, or for each computer
in a cluster. See Using Cluster Storage.

Setting Cluster Administrator and User Passwords
You can create cluster passwords while creating a new cluster, as described in Creating
Clusters with Apple Qadministrator. However, once the cluster is created, you can still
add or change passwords, using the same settings in Apple Qadministrator.

To create or change cluster passwords
1 In Apple Qadministrator, select the cluster from the Cluster list.

2 Click Security.

3 Select and enter or change the passwords you want.

4 Click Apply.

Note: Cluster administrator and cluster user passwords can be stored in a user’s keychain.

Setting a Service Password for Including a Computer in a Cluster
If you want to control who is able to include a specific service node or cluster controller
in a cluster, you can create a password called a service password for the computer.
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Note: A service password can be stored in a user’s keychain.

To set a service password
1 On the computer designated as the service node or cluster controller, open the

Apple Qmaster pane of System Preferences.

2 If any Apple Qmaster services are enabled on this computer, temporarily turn them off
by clicking Stop Sharing.

3 Click Require Password.

The password dialog opens.

4 Enter and verify a password, then click OK.

5 Select the relevant checkbox or click the Start Sharing button to restart the services you
need on this computer.

Scheduling Service Availability
If you enabled unmanaged services, you can open a calendar interface and schedule the
availability of these services to the distributed processing system.
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About the Work Schedule Dialog
The calendar interface of the work schedule dialog contains several useful features.

You can use the following controls to constrain the availability of unmanaged services
for each day of the week:

• On/Off pop-up menu: Use this pop-up menu to turn services on or off for a particular
day of the week.

• On: This setting indicates that the services are available for all 24 hours of that
particular day. (This is the default setting for all seven days of the week.)

• Off: Makes the service unavailable on that day of the week.

• On between: Allows you to enter the period of time the service will be available.

• Off between: Allows you to enter the period of time the service will not be available.

• Start time field: Enter a start time.

• End time field: Enter an end time.

Scheduling Service Availability in the Work Schedule Dialog
Follow the steps below to schedule the availability of unmanaged services.

To schedule service availability
1 In the Advanced pane within the Apple Qmaster preferences pane, click Set.

The work schedule dialog appears.
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2 To constrain the availability of the services, choose one of the options from the pop-up
menu next to a particular day of the week. See About the Work Schedule Dialog for details.

3 Enter any constraining time periods in the appropriate start time and end time fields.

Note: You must enter valid days and times. The time cannot overlap into the next day in
one entry. There must be two entries when the range ends after 12 a.m. For more
information, see Setting Availability from Sunday Night to Monday Morning.

4 Click OK to save the settings.

Setting Availability from Sunday Night to Monday Morning
You must enter valid days and times. The time cannot overlap into the next day in one
entry. There must be two entries when the range ends after 12 a.m.

For example, to set the service availability from 6 p.m. on Sunday to 8 a.m. on Monday,
follow the steps below.

To provide service availability from Sunday night to Monday morning
µ Make both of the following entries:

• Sunday: On between 6:00 PM and 12:00 AM

• Monday: On between 12:00 AM and 8:00 AM

Using Cluster Storage
By default, the Apple Qmaster distributed processing system saves temporary process
files in the /var/spool/qmaster/ directory on the cluster controller. You can also choose
any other location on a local disk for this scratch storage. Computers in the cluster will
access this location as needed.

Selecting a Cluster Storage Location
Follow the steps below to change the cluster storage location.

To select a new storage location for a cluster
1 On the cluster controller, open the Apple Qmaster pane of System Preferences.

2 If any Apple Qmaster services are enabled on this computer, click Stop Sharing to
temporarily turn them off.

3 Click Advanced to open the Advanced pane.
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4 Click the Set button next to the Cluster Storage field.

Click Set to open a
dialog for choosing
a new storage folder.

5 Navigate to the folder in the dialog, select it, and then click Choose.

Note: If you are using the default This Computer setting in the Cluster pop-up menu in
the Compressor Batch window and you choose Cluster Storage as the destination, the
output file will be copied to the Source location.

Cluster Storage Capacity
If you are processing large source media files that exceed the available storage space on
the startup disk, you may run out of storage space on that disk. There are a number of
things you can do to address this.

• Change the cluster storage location to a disk with more free space. For more information,
see Adjusting Cluster Storage Settings.

• Configure cluster storage settings to delete files more frequently. For more information,
see Adjusting Cluster Storage Settings.

• Compressor users can set Cluster Options preferences (choose Compressor >
Preferences) to “Never copy source to cluster.” For more information, see the Compressor
User Manual.

Adjusting Cluster Storage Settings
Follow the steps below to change scratch storage settings for a cluster.
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To change cluster storage settings
1 On the cluster controller, open the Apple Qmaster pane of System Preferences.

2 If any Apple Qmaster services are enabled on this computer, click Stop Sharing to
temporarily turn them off.

Note: Do not attempt to change the cluster storage settings while the cluster is turned
on.

3 Click Advanced to open the Advanced pane.

4 Configure the following optional settings:

• To change the cluster storage location: Click the Set button next to the Cluster Storage
field, then navigate to the folder in the dialog and click Choose.

• To change how often cluster storage files are deleted: Enter a new number in the Delete
Files Older Than N Days field.

Click Set to open a
dialog for choosing
a new storage folder.

Enter a new number to 
change how often cluster 
storage files are deleted.

Click Stop Sharing to
turn off the cluster
before changing
any settings.

5 Click the Start Sharing button to restart the cluster.

Cleaning Up Cluster Storage
If you are using cluster storage and an error occurs, partial files may be left on the
designated cluster storage location. Check the designated cluster storage location to
make sure no partial media files are left there. If you find partial media files, delete them
and submit the job again.
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QuickTime Reference Movies
If you submit a reference movie for distributed processing, the Apple Qmaster distributed
processing system will automatically copy the appropriate media files to the processing
cluster. For the best performance, you can avoid this file transfer step by making sure
that the media files specified in the reference movie are available to each node of the
Apple Qmaster cluster.

Defining Ports for Service Advertisements
You can define which ports Apple Qmaster uses for service advertisements with the
Enable Port Range checkbox and text fields in the Network section of the Advanced pane
within the Apple Qmaster pane of System Preferences.

To define ports for Apple Qmaster service advertisements
1 Open the Apple Qmaster pane of System Preferences.

2 Click Advanced to open the Advanced pane.

3 Select Enable Port Range.

4 In the From field, enter any integer value between 50,000 and 65,535 to set the start of
the range.

5 In the “Number of ports” field, enter the size of the range, such as 1000.

Recovery and Failure Notification Features
The Apple Qmaster distributed processing system has a number of built-in features
designed to attempt recovery if there is a problem, and to notify you when the system
attempts a recovery.

Recovery Features
The recovery actions described next occur automatically if failures occur in the
Apple Qmaster distributed processing system. There is no need for you, as the
administrator, to enable or configure these features.

If a Service Stops Unexpectedly
If either the cluster controller service or the processing enabled on a service node stops
unexpectedly, the Apple Qmaster distributed processing system restarts the service. To
avoid the risk of endless stopping and restarting, the system restarts the failed service a
maximum of four times. The first two times, it restarts the service right away. If the service
stops abruptly a third or fourth time, the system restarts the service only if it had been
running for at least 10 seconds before it stopped.
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If a Batch Is Interrupted
When a service stops suddenly while in the middle of processing an Apple Qmaster batch,
the cluster controller resubmits the interrupted batch in a way that prevents the
reprocessing of any batch segments that were complete before the service stopped. The
cluster controller delays resuming the batch for about a minute from the time it loses
contact with the service.

If a Batch Fails
When the service is running, but one batch fails to process, a service exception occurs.
When this happens, the cluster controller resubmits the batch immediately. The cluster
controller resubmits the batch a maximum of two times. If the job fails on the third
submission, the distributed processing system stops resubmitting the job. In Batch Monitor,
the job is moved to the History table, where the status column indicates that a failure
occurred.

Failure Notification
There are two different ways that the Apple Qmaster distributed processing system can
provide information about a problem.

Email Notification
When a processing service stops unexpectedly, Apple Qmaster sends a notification email
to the address that was entered in the Apple Qadministrator Cluster Preferences dialog
for that cluster. If no address was entered there, the email is sent to the address in the
Internet settings of the computer on which the cluster controller is enabled.

Note: Apple Qmaster does not currently support SMTP servers that require authentication.

Log Files for Individual Jobs or Batches
If a particular job or batch fails, a log file is generated that describes this failure. You can
find the name and location of this log file through Batch Monitor.

To find the name and location of a log file
1 Select the batch or job in the History table of the Batch Monitor window.

2 Click the Info icon.

If any log files were generated because of failures in the processing of the item, the names
and locations of those logs are shown.

Notification and Log Labels
The following table lists the service labels used in the email notifications and logs.

Notification labelProcessing service type

servicecontroller:com.apple.stomp.transcoderLocal Compressor service

servicecontroller:com.apple.stomp.transcoderxDistributed Compressor service

74 Chapter 6 Administering Clusters



Notification labelProcessing service type

servicecontroller:com.apple.qmaster.executorDistributed Apple Qmaster
service
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If you are accustomed to doing your work from Terminal shells, and you need or prefer
to run the distributed processing system from the command line with minimal use of
application interfaces, this appendix is for you.

Note: Although it is possible to use the command line to run an Apple Qmaster distributed
processing network, each Compressor service node (each computer providing Compressor
distributed processing services) must be logged in (with a Mac OS X user name and
password) for full functionality.

This chapter covers the following:

• Installing Apple Qmaster from the Command Line (p. 77)

• Using the Command Line for Distributed Processing (p. 78)

• Using Scripts to Run Apple Qmaster, Compressor, and Batch Monitor (p. 85)

Installing Apple Qmaster from the Command Line
Follow these steps to install Apple Qmaster software on each computer you want to use
for distributed processing. (All computers must be on the same subnet.)

Note: On any given Final Cut Studio system or network, the Compressor and
Apple Qmaster versions (numbers) and the version of QuickTime must all match. For
example, Compressor 3.0.5 will work only with the 3.0.5 version of Apple Qmaster, and
no other version. In this example, the correct version of QuickTime is QuickTime 7.5.5 or
later. Non-matching configurations are not supported.

To install Apple Qmaster software from the command line
1 Copy the standalone installer package (AppleQmasterNode.mpkg) to the remote system.

Note: Do not alter the file hierarchy of the packages.

2 Log in to the remote system.

3 Enter the following command:

sudo installer -pkg AppleQmasterNode.mpkg -target /

Apple Qmaster processes start automatically after installation.
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4 Repeat these steps for each computer in your distributed processing network.

Tip: You can also install Apple Qmaster using Apple Remote Desktop. Just select a node,
click Install Package, and select the standalone installer package
(AppleQmasterNode.mpkg). The copy and installation process is done automatically.

Using the Command Line for Distributed Processing
The following sections describe how to issue shell commands (from the command line)
to run your distributed processing network.

Shell Commands for Configuring Service Nodes and Cluster Controllers
As an alternative to using the Apple Qmaster pane in System Preferences, you can use
the command qmasterprefs, with command-line options for enabling and disabling
service node and cluster-controlling services.

In the command-line descriptions below, angle brackets < > indicate a mandatory
argument in a command, and brackets [ ] indicate an optional argument.

Synopsis
Below is a synopsis of the command for enabling and disabling Apple Qmaster services
on a computer. The qmasterprefs command is located in /usr/sbin.

qmasterprefs [options] [-cluster <on | off> [options]] [-service <name> <on

 | off> [options]]

Command Options
This table provides information about each of the enabling and disabling service-node
and cluster-controlling services on a computer.

DescriptionPreference command option

Displays information about supported options for qmasterprefs.-help

Lists the current qmasterprefs settings.-list

Restarts cluster processes. cancelJobs deletes batches in the
queue.

-resetCluster 

[cancelJobs]

Enables or disables Bonjour advertisements.-allowBonjourDiscovery 

<on | off>

Sets sharing state. (Similar to the Apple Qmaster pane in System
Preferences.)

-startSharing 

[servicesOnly | 

servicesAndCluster | 

servicesAndQuickCluster]

Stops Apple Qmaster services on local computer.-stopSharing

Restarts all Apple Qmaster services.-restart

Resets Apple Qmaster services to default configuration.-reset
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DescriptionPreference command option

Automatically launches content agent at startup.-launchContentAgent <on

 | off>

Sets logging level. Default is 3. Off is 0. Sets whether logs are
overwritten when services are restarted.

-log [0-5] [truncate on

 | off]

Displays service node status indicator in menu bar.-statusMenu <on | off>

Turns cluster-controlling services on or off. All [options] are:
[timeout min] [[quickcluster] servername name]  

[maxactivetargets val] [maxactivesegments val] 

[storagepath path] [privatestorage on|off] 

[publishedstorage on|off] 

[storagecleanupthreshold days] [unmanagedservices

 on|off] [unmanagedmulticapturethreshold sec] 

[networkinterface allinterfaces | <bsd name>] 

[log [0-5] | [truncate on|off]]

-cluster  <on | off> 

[options]

Turns service on or off. Valid names are Rendering or
"Compressor Processing". All [options] are: [timeout min]
[sharing on|off ] [instances n] [autorestart on|off ] [unmanaged on|off ]
[log [0-5] [truncate on|off ]]

-service “name” [on|off]

 [options]

Note: For a complete list of shell command options, enter qmasterprefs -help.

Example of the qmasterprefs Command
In the following example, the computer is set to be a cluster controller, bound to the
primary network interface (en0), with logging set to verbose, with the logs not overwritten.
The Rendering service is on, with 4 managed services and logging set to verbose, with
the logs not overwritten. The Compressor Processing service is configured with the
same settings, with two instances.

qmasterprefs -sharingType servicesAndCluster -cluster on networkinterface 

en0 log 5 truncate off -service Rendering on sharing on instances 4 unmanaged

 off log 5 truncate off -service "Compressor Processing" on sharing on 

instances 2 unmanaged off log 5 truncate off

To reset controller and service configurations
µ Enter the following:

qmasterprefs -reset 

To reset all controller and service processes and cancel all batches in queue
µ Enter the following:

qmasterprefs -resetCluster cancelJobs

To stop sharing
µ Enter the following:

qmasterprefs -stopSharing 
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To start sharing
µ Enter the following:

qmasterprefs -startSharing

To change the cluster storage path to an Xsan volume
µ Enter the following:

qmasterprefs -cluster off storagepath /Volumes/XsanVol

To change the number of Compressor Processing services from 2 to 4
µ Enter the following:

qmasterprefs -service "Compressor Processing" off sharing on instances 4

To turn off the Rendering service
µ Enter the following:

qmasterprefs -service Rendering off

To turn on unmanaged services for Compressor Processing
µ Enter the following:

qmasterprefs -service “Compressor Processing” on unmanaged on

To configure a service-only node
µ Enter the following:

qmasterprefs -stopSharing -sharingType servicesOnly -startSharing

To create a QuickCluster
µ Enter the following:

qmasterprefs -stopSharing -sharingType servicesAndQuickCluster -startSharing

Shell Commands for Submitting Compressor Jobs
You can run the Compressor application from the command line using the Compressor

command, with a number of command-line options for submitting jobs.

In the command-line descriptions below, angle brackets < > indicate a mandatory
argument in a command, and brackets [ ] indicate an optional argument.

Synopsis
Below is a synopsis of the command for submitting a job to a cluster. The Compressor

command is located in /Applications/Compressor.app/Contents/MacOS/.

Compressor [-clustername <name>][-clusterid 

<username:password@ipaddress:portNumber>] [-batchfilepath <path>] [-batchname

 <batchname>] [-priority <value>] [-jobpath <path>] [-settingpath <path>] 

[-destinationpath <path>] [-info <xml>] [-timeout <seconds>] [-help] [-show]

In this example, -jobpath, -settingpath, and -destinationpath can be repeated as
many times as the number of jobs you want to submit.
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Note: Not all the options are necessary. For example, you can specify the cluster either
by its -clustername or by its -clusterid. You do not need to specify both. If both are
specified, only -clusterid is used.

Additionally, if you specify -batchfilepath, then -jobpath, -settingpath, and
-destinationpath are not necessary because the previously saved batch file already
contains information about the job, settings, and destination.

Example of -batchfilepath:

Compressor -clustername "This Computer" -batchfilepath 

"/Volumes/Hermione/SavedCompressorBatches/FreeChampagne.compressor"

Once the job is submitted successfully, this command displays the batch ID (identifier)
and job ID (identifier) in the shell, and you can monitor the progress of a batch in
Batch Monitor.

Command Options
This table provides information about each of the command options for submitting jobs.

DescriptionSubmission command option

Use to specify the name of the cluster to which you want to send
the job. Using the cluster name, Compressor looks for the cluster
on the network in order to use it.

-clustername <name>

User password for the cluster specified by ID or name.-password <value>

Use to specify a name for the batch so that you can easily recognize
it in Batch Monitor.

-batchname <name>

Optionally, you can use -clusterid to enter the cluster ID and
port number instead of using -clustername. (When you enter
the cluster ID and port, less time is required to find the cluster on
the network.)
Or, if you used -clustername and the cluster requires a password,
use -clusterid to specify the user name and password. (You
need to include theIP address:port number as well whenever
you use -clusterid.)
Use Compressor -show to see a cluster's IP address and port
number.

-clusterid <user 

name:password@IP 

address:port number>

Specifies the priority level for a job.-priority <value>

Specifies the location of the source file.-jobpath <url>

Specifies the location of the settings for the job.-settingpath <url>

Specifies the destination file URL for the job.-destinationpath <url>

Gives detailed information for a batch or a job.-info <xml>
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DescriptionSubmission command option

Use to specify the number of seconds before Compressor can quit
when looking for a cluster. The default value is 0, which puts no
limit on the timeout and allows Compressor to browse the network
for as long as it needs to find the cluster.

-timeout <seconds>

Shows the ID information for the cluster specified with
-clustername or -clusterid, or for all clusters if no cluster is
specified.

-show

Displays information regarding the required parameters for the
Compressor command.

-help

Example of Compressor Command XML
The code below is an example of XML code for submitting a Compressor command.
Notice that because it needs to be entered as one command line, every character after
-options that isn’t alphanumeric must be preceded with a backslash (\).

./Compressor -clusterid tcp://127.0.0.1:51737 -batchname myBatch -jobpath 

/Volumes/Source/ShortClips/NTSC24p.mov -settingpath 

/Users/stomper10/Library/Application\ Support/Compressor/PhotoJPEG.setting

 -destinationpath /Users/machinename/Movies/myDestinationFilename.mov.

This command has the following elements:

• Cluster address is tcp://127.0.0.1:51737.

• Batch name is myBatch.

• Job path is /Volumes/Source/ShortClips/NTSC24p.mov.

• Setting path is /Users/stomper10/Library/Application
Support/Compressor/PhotoJPEG.setting.

• Destination path is /Users/machinename/Movies.

Shell Commands for Submitting Apple Qmaster Jobs
You can use the Apple Qmaster command, Apple Qmaster, with a number of
command-line options for submitting jobs.

In the command-line descriptions below, angle brackets < > indicate a mandatory
argument in a command, and brackets [ ] indicate an optional argument.

Synopsis
Below is a synopsis of the command for submitting a job to a cluster. The Apple Qmaster

command is located in /Applications/Apple Qmaster.app/Contents/MacOS/.

Apple Qmaster [-clustername <name>] [-clusterid <user name:password@IP 

address:port number>][-command <command type> -options <XML command> 

[-wd<working directory>] [-timeout <seconds>] [-show] [-batchname <name>] 

[-help]
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Once the job is submitted successfully, this command displays the batch ID (identifier)
and job ID (identifier) in the shell.

Command Options
This table provides information about each of the command options for submitting jobs.

DescriptionSubmission command option

Use to specify the name of the cluster to which you want to send
the job. Using the cluster name, Apple Qmaster looks for the cluster
on the network in order to use it.

-clustername <name>

Use to specify a name for the batch so that you can easily recognize
it in Batch Monitor.

-batchname <name>

Optionally, you can use -clusterid to enter the cluster ID and
port number instead of using -clustername. (When you enter
the cluster ID and port, less time is required to find the cluster on
the network.)
Or, if you used -clustername and the cluster requires a password,
use -clusterid to specify the user name and password. (You
need to include theIP address:port number as well whenever
you use -clusterid.)
Use Apple Qmaster -show to see a cluster’s IP address and port
number.

-clusterid <user 

name:password@IP 

address:port number>

Specifies the kind of command you are entering: Shell, Shake,
Maya, or other command, depending on the application you want
to use for distributed processing.

-command <command type>

Specifies the command with XML code. Enter the XML code after
-options, with the necessary qualifiers for entering it in a shell.
See Example of Shake Command XML, next, for an example.
If no -option is entered, the values from the application’s
preferences file, in ~/Library/Preferences/, are used (which are the
values of the most recent job submitted).

-options <XML command>

Use to specify the working directory path (from which the command
should be executed). The default working directory is
/Applications/Shake.

-wd <working directory>

Use to specify the number of seconds before Apple Qmaster can
quit when looking for a cluster. The default value is 0, which puts
no limit on the timeout and allows Apple Qmaster to browse the
network for as long as it needs to find the cluster.

-timeout <seconds>

Shows the ID information for the cluster specified with
-clustername or -clusterid, or for all clusters if no cluster is
specified.

-show

Displays information about supported options forApple Qmaster.-help

Example of Shake Command XML
The code below is an example of XML code for submitting a Shake command.
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/Applications/Apple\ Qmaster.app/Contents/MacOS/Apple\ Qmaster -clustername

 elvis -command "Shake" -options "<command 

executable="/Applications/Shake/shake.app/Contents/MacOS/shake" 

script="/Volumes/Data/scripts/applestyle.shk" start="1" end="1000" 

stepsOf="1" minCount="10" otherOptions="" previewNode="" previewWidth="0" 

shutterOn="yes" motion="yes" proxyFlags="0" proxyScale="1.000000" 

proxyRatio="1000.000000" shutter="1.000000"></command>"

Note: Apple Qmaster stores the XML code for the last command you entered in
~Library/Preferences/com.apple.AppleQmaster.plist. You can copy the command in XML
form there, and customize it to use for a new job submission.

Shell Commands for Monitoring Batches
You can use the Batch Monitor command, Batch Monitor, with a number of command-line
options for monitoring jobs.

In the command-line descriptions below, angle brackets < > indicate a mandatory
argument in a command, and brackets [ ] indicate an optional argument.

Synopsis
Below is a synopsis of the command for monitoring batches. The Batch Monitor command
is located in /Applications/Utilities/Batch Monitor.app/Contents/MacOS/.

Batch Monitor [-clustername <name>] [-clusterid <user name:password@IP 

address:port number>] [-jobid <identifier> -batchid <identifier>] [-timeout

 <seconds>] [-query <seconds>] [-help]

To cancel a job or batch
µ Use the following command:

Batch Monitor [-clustername <name>] [-clusterid <IP address> <port number>

 <user name> <password>] -kill -jobid <identifier> -batchid <identifier>

Command Options
This table provides information about each of the command options for monitoring
batches.

DescriptionMonitoring command option

Use to specify the name of the cluster to which the job was sent.-clustername <name>

User password for the cluster specified by ID or name.-password <value>

Optionally, you can use -clusterid to enter the cluster ID and
port number instead of using -clustername.
Or, if you used -clustername and the cluster requires a password,
use -clusterid to specify the user name and password. (You
need to include theIP address:port number as well whenever
you use -clusterid.)
Use Apple Qmaster -show or Compressor -show to see a
cluster’s IP address and port number.

-clusterid <user 

name:password@IP 

address:port number>
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DescriptionMonitoring command option

Use to specify the job you want to monitor.
When you use the -jobid option, you must also specify the
-batchid, in the form of the name that was given to the batch
when it was submitted. (The -batchid and -jobid are displayed
after a batch is submitted.)
If you do not use the -jobid option, all the jobs submitted to the
specified cluster are listed.

-jobid <identifier> 

-batchid <identifier>

Use to specify the number of seconds before Batch Monitor can
quit when looking for a cluster. The default value is 0, which puts
no limit on the timeout and allows Batch Monitor to browse the
network for as long as it needs to find the cluster.

-timeout <seconds>

Use to specify how frequently, in seconds, the job status should be
updated.

-query <seconds>

Cancels the specified job or batch.-kill -jobid 

<identifier> -batchid 

<identifier>

Displays information about supported options forBatch Monitor.-help

Using Scripts to Run Apple Qmaster, Compressor, and
Batch Monitor
To simplify your use of the command line, you can add command-line friendly scripts to
/usr/bin. Each script sets an ENV variable for location and then executes the binary. Using
the following scripts would be useful if you frequently use the command line for
submissions or automated submissions. You do not need to specify the full path, and
you can add frequently used ENV variables and options to speed up the submission
process. To run Apple Qmaster, Compressor, or Batch Monitor, you can simply open up
a terminal and type qmaster, compressor, or batchmonitor.

Apple Qmaster Script Example
#!/bin/csh -f 

# 

# set env var, QMASTER_LOCATION if not set 

# 

if ${? QMASTER_LOCATION} == 0 then 

  pushd `dirname $0` >& /dev/null 

  setenv QMASTER_LOCATION /Applications/Apple\ Qmaster 

  popd >& /dev/null 

endif 

# 

# launch qmaster 

# 

exec ${QMASTER_LOCATION}/Apple\ Qmaster.app/Contents/MacOS/Apple\ Qmaster 

$argv:q 
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Compressor Script Example
#!/bin/csh -f 

# 

# set env var, COMPRESSOR_LOCATION if not set 

# 

if ${?COMPRESSOR_LOCATION} == 0 then 

  pushd `dirname $0` >& /dev/null 

  setenv COMPRESSOR_LOCATION /Applications/Compressor.app/Contents/MacOS 

  popd >& /dev/null 

endif 

# 

# launch Compressor 

# 

exec ${COMPRESSOR_LOCATION}/Compressor $argv:q

Batch Monitor Script Example
#!/bin/csh -f 

# 

# set env var, BATCHMONITOR_LOCATION if not set 

# 

if ${?BATCHMONITOR_LOCATION} == 0 then 

  pushd `dirname $0` >& /dev/null 

  setenv BATCHMONITOR_LOCATION "/Applications/Utilities/Batch Monitor.app/

Contents/MacOS" 

  popd >& /dev/null 

endif 

# 

# launch Batch Monitor 

# 

exec "${BATCHMONITOR_LOCATION}/Batch Monitor" $argv:q

86 Chapter 7 Using the Command Line



If you are having trouble with your Apple Qmaster distributed processing system, look
here for answers to your questions.

This appendix covers the following:

• Resources for Solving Problems (p. 87)

• Solutions to Common Problems (p. 87)

• Contacting AppleCare Support (p. 92)

Resources for Solving Problems
If you run into problems while working with Compressor or the Apple Qmaster distributed
processing system, there are several resources you can use to find a solution.

• This appendix: This appendix includes information about some of the most frequent
issues users encounter.

• Release Notes: The Release Notes document, available from the Help menu, provides
up-to-date information that didn’t make it into the manual. Be sure to consult this
document as soon as you install or upgrade Compressor or Apple Qmaster.

• AppleCare Knowledge Base: AppleCare Support maintains a database of common support
issues that is updated and expanded to include new issues as they arise. This is an
excellent, free resource for Compressor and Apple Qmaster users. To access the
AppleCare Knowledge Base, go to the AppleCare support page at
http://www.apple.com/support.

• AppleCare Support: There are a variety of support options available to Final Cut Studio
customers. For more information, see the Apple service and support information that
was included with your Final Cut Studio package.

Solutions to Common Problems
The following sections address some common issues.
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Exporting from Final Cut Pro and Distributed Processing
You can use Compressor to transcode sequences or clips from within other applications,
such as Final Cut Pro. This saves time and hard disk space by eliminating the need to
export self-contained media files before processing them.

There are two methods you can use to avoid exporting self-contained media files for
Compressor distributed processing:

• Export a sequence directly from Final Cut Pro to Compressor and then submit that job
to a cluster in an Apple Qmaster distributed processing network. In this workflow,
Final Cut Pro opens on each processing node in that cluster to complete the job.

• Export the Final Cut Pro sequence as a QuickTime reference movie and then submit
the resulting movie to the cluster for processing. Because this method does not involve
Final Cut Pro, you are free to use Final Cut Pro while the batch is being processed in
the background. If you submit a reference movie for distributed processing, the
Apple Qmaster distributed processing system will automatically copy the appropriate
media files to the processing cluster. For the best performance, you can avoid this file
transfer step by making sure that the media files specified in the reference movie are
available to each node of the Apple Qmaster cluster. Below, you will find two sets of
instructions for submitting reference movies: one with automatic file transfer and one
with preparatory steps for maximizing performance.

Note: You can also use distributed processing with the Share feature in Final Cut Pro and
Motion. For more information, see the Final Cut Pro User Manual or the Motion User Manual.

To export a Final Cut Pro sequence directly to Compressor for distributed processing
1 Make sure Final Cut Pro is installed on each computer in the cluster that you intend to

use for distributed processing.

Each installation of Final Cut Pro requires a product serial number. For information about
volume licenses, go to http://www.apple.com/finalcutstudio.

Note: On any given Final Cut Studio system or network, the Compressor and
Apple Qmaster versions (numbers) and the version of QuickTime must all match. For
example, Compressor 3.0.5 will work only with the 3.0.5 version of Apple Qmaster, and
no other version. In this example, the correct version of QuickTime is QuickTime 7.5.5 or
later. Non-matching configurations are not supported.

2 Make sure all of the source media files and render files for your Final Cut Pro project are
on a hard disk that can be shared (mounted) by all the computers in the cluster that will
process the job. (The following instructions use an example of a shared hard disk named
Media1.)

If you copy all the media files to another hard disk for this purpose, you may need to
reconnect the media files in Final Cut Pro before proceeding.

88 Appendix Solving Problems

http://www.apple.com/finalcutstudio


Important: The hard disk you use to store the media files may not be a startup disk for
any computer in the cluster.

3 In Final Cut Pro, set the scratch disk to the same hard disk used for storing media files in
step 2:

a Choose Final Cut Pro > System Settings, then click the Scratch Disks tab.

b Click Set.

c In the dialog that appears, locate and select the disk you want to use (Media1 in this
example).

d Click Choose. The specified disk (Media1) is listed next to the Set button, along with
the amount of available disk space.

For more information about Final Cut Pro scratch disks, see the Final Cut Pro User Manual.

4 Enable file sharing on the computer where the scratch disk (Media1) is located (in the
Sharing pane of System Preferences, click Services and then select Personal File Sharing).

5 On each computer in the intended cluster, mount the scratch disk you specified in step
3 (in the Finder sidebar, click Network, navigate to the computer that contains the Media1
disk, click Connect, and select Media1).

6 In Compressor preferences, specify cluster options settings:

a Choose Compressor > Preferences, or press Command-Comma (,).

The Preferences window appears.

b Choose “Copy Source to Cluster as Needed” from the Cluster Options pop-up menu.

7 In Final Cut Pro, choose File > Export > Using Compressor.

Compressor opens with the selected media file (the Final Cut Pro sequence) in the Batch
window.

8 In Compressor, double-click the selected file and play it in the Preview window to verify
the integrity of the clip.

9 In the Batch window, assign settings and destinations to the selected file as necessary.

10 Choose the intended cluster from the Cluster pop-up menu in the lower-left corner of
the Batch window.

11 Click Submit.

To export a Final Cut Pro sequence as a QuickTime reference movie and submit it to
Compressor for distributed processing using automatic file transfer

1 In Final Cut Pro, choose File > Export > QuickTime Movie.

2 In the Save dialog, make sure that the Make Movie Self-Contained checkbox is not selected.

3 Import the QuickTime reference movie into Compressor. (Drag it from the desktop to the
Compressor Batch window.)
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4 In the Batch window, assign settings and destinations to the selected file as necessary.

5 Click the Submit button.

The submit dialog appears.

6 Do one of the following:

• Choose the intended cluster from the Cluster pop-up menu.

• Select the “Include unmanaged services on other computers” checkbox to use the
AutoCluster feature. See Using Compressor AutoClusters for more information.

7 Click Submit.

The Apple Qmaster distributed processing system automatically copies the appropriate
media files to the cluster and processes the batch.

To export a Final Cut Pro sequence as a QuickTime reference movie and submit it to
Compressor for distributed processing using preparatory steps to maximize
performance

1 Make sure all the source media files and render files for your Final Cut Pro project are on
a hard disk that can be shared (mounted) by all the computers in the cluster that will
process the job. (The following instructions use an example of a shared hard disk named
Media1.)

If you copy all the media files to another hard disk for this purpose, you may need to
reconnect the media files in Final Cut Pro before proceeding.

Important: The hard disk you use to store the media files may not be a startup disk for
any computer in the cluster.

2 In Final Cut Pro, choose File > Export > QuickTime Movie.

3 In the Save dialog, make sure that the Make Movie Self-Contained checkbox is not selected.

4 Save the QuickTime reference movie to the same hard disk (Media1) used to store media
files in step 1.

5 Enable file sharing on the computer where the scratch disk (Media1) is located (in the
Sharing pane of System Preferences, click Services and then select Personal File Sharing).

6 On each computer in the intended cluster, mount the hard disk (Media1) where the media
files and QuickTime reference movie are located (in the Finder sidebar, click Network,
navigate to the computer that contains the Media1 disk, click Connect, and select Media1).

7 In Compressor preferences, specify cluster options settings:

a Choose Compressor > Preferences, or press Command-Comma (,).

The Preferences window appears.

b Choose “Never Copy Source to Cluster” from the Cluster Options pop-up menu.

8 Import the QuickTime reference movie into Compressor. (Drag it from the desktop to the
Compressor Batch window.)
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9 Double-click the file in the Batch window and play it in the Preview window to verify the
integrity of the clip.

10 In the Batch window, assign settings and destinations to the selected file as necessary.

11 Click the Submit button.

The submit dialog appears.

12 Do one of the following:

• Choose the intended cluster from the Cluster pop-up menu.

• Select the “Include unmanaged services on other computers” checkbox to use the
AutoCluster feature. See Using Compressor AutoClusters for more information.

13 Click Submit.

QuickTime Reference Movies
If you submit a reference movie for distributed processing, the Apple Qmaster distributed
processing system will automatically copy the appropriate media files to the processing
cluster. For the best performance, you can avoid this file transfer step by making sure
that the media files specified in the reference movie are available to each node of the
Apple Qmaster cluster.

Cluster Settings for Extended Transcoding Sessions
If you are using Compressor 2 or later for distributed processing, and you anticipate a
transcoding session that will last up to seven days or longer, you must make an adjustment
in the Advanced section of the Apple Qmaster preferences pane. By default, temporary
process files may remain on a cluster’s scratch location for seven days before they are
automatically deleted. You can increase this value (the number of days) in the
Apple Qmaster pane of System Preferences.

Cleaning Up Cluster Storage
If you are using cluster storage and an error occurs, partial files may be left on the
designated cluster storage location. Check the designated cluster storage location to
make sure no partial media files are left there. If you find partial media files, delete them
and submit the job again.

Using Apple Qmaster with an NFS Server
By default, Apple Qmaster uses /etc/exports to define its Cluster Storage export. This can
cause a conflict if you defined an NFS export in your local NetInfo database. When you
enable a controller using Apple Qmaster 2 or later, Apple Qmaster uses /etc/exports, not
entries defined in your NetInfo database. To work around this issue, either move the
exports to /etc/exports, or move the controller to a computer that doesn’t export anything.
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Apple Qmaster Distributed Processing and Xsan
Here are some tips on using the Apple Qmaster distributed processing system with Xsan
systems.

Restarting Apple Qmaster and Xsan Systems
Using previous versions of Apple Qmaster distributed processing on an Xsan system may
cause mounting problems when restarting an Apple Qmaster distributed processing
cluster controller. You must restart Apple Qmaster and Xsan computers in the exact order
described below.

To restart Apple Qmaster and Xsan computers
1 Turn off the cluster controller by clicking Stop Sharing in the Apple Qmaster pane of

System Preferences.

2 Restart the Apple Qmaster cluster controller computer.

3 Wait for the Xsan volume to mount on the desktop.

4 Click Start Sharing in the Apple Qmaster pane of System Preferences to restart the
controller.

Xsan Compatibility
Xsan 1.3 is not compatible with Compressor and the Apple Qmaster distributed processing
system when Xsan media drives are used for cluster (scratch) storage. To use Xsan with
Apple Qmaster 2.3, update to Xsan 1.4.

To download and install Xsan 1.4
µ Go to http://www.apple.com/support/xsan.

Compressor Command-Line Usage Requires Login
Although it is possible to use the command line to run an Apple Qmaster distributed
processing network, each Compressor service node (each computer providing Compressor
distributed processing services) must be logged in (with a Mac OS X user name and
password) for full functionality.

Contacting AppleCare Support
Information about the support options available from Apple is included in your
Final Cut Studio package. Several levels of support are available.

Whatever your issue, it’s a good idea to have the following information immediately
available when you contact Apple for support. The more of this information you have to
give to the support agents, the faster they will be able to address your issue.

• The Support ID number found on the back of the Installing Your Software booklet that
came with Final Cut Studio.
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Note: The 11-digit Support ID number is different from the product serial number used
to install Final Cut Studio.

• The version of Mac OS X you have installed. This information can be viewed by choosing
About This Mac from the Apple menu.

• The version of Compressor and Apple Qmaster you have installed, including updates
if applicable. The version number can be viewed by choosing Compressor > About
Compressor and Apple Qmaster > About Apple Qmaster.

• The model of computer you are using.

• The amount of RAM installed in your computer, and how much is available to
Compressor and Apple Qmaster. You can find out how much RAM is installed by
choosing About This Mac from the Apple menu.

• What other third-party hardware is connected to or installed in the computer, and who
the manufacturers are. Include hard disks, graphics cards, and so on.

• Any third-party plug-ins or other software installed along with Compressor or
Apple Qmaster.

In certain support situations, AppleCare may require information about both your
computer and how this particular application is configured. Choosing Help > Create
Support Profile creates a file that contains the necessary information and can be emailed
to AppleCare. You would not normally use this feature unless directed to by an AppleCare
representative.

AppleCare can be reached online at one of the following locations:

• For Compressor support: Go to http://www.apple.com/support/compressor.

• For Apple Qmaster support: Go to http://www.apple.com/support/qmaster.

There is also an item in the Help menu that will take you directly to the AppleCare website.

To go to the AppleCare website from within Compressor or Apple Qmaster
µ Do one of the following:

• In Compressor, choose Help > Compressor Support.

• In Apple Qmaster, choose Help > Apple Qmaster Support.
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